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Note: Case is not significant in names. Also, space characters are 
not changed to the underbar ("_") character within the formula 
panel. Be aware that the spelling (upper/lower or upper and lower) 
of a given name is shared within a report or database file and that tht 
most recent spelling entered becomes the model for future entries of 
that name. For example, if you had a field in one repeating collectior 
called J obStatus and you added a field called jobstatus in another 
repeating collection, both would then appear as jobstatus. 

A Repeating Collection is the report mechanism which provides a 
view on the records in a database file or even in another repeating 
collection. Repeating Collections may be nested (placed within each 
other) so that you can produce lists of lists. 

To create a Repeating Collection: 

> Draw a generic black box anywhere in a report window. Go to the 
Describe menu and select Repeating Collection option. A repeating 
collection, recognizable by its two vertical handlebars, will appear. 

To nest repeating collections: 

> Simply create or place them within each other. Be aware that 
repeating collections may not overlap each other - as with all 
Reflex objects except pictures. 

Note: It is important that you always change a Repeating 
Collection's default name to something more meaningful-see 
Names, above. Be aware that when a report is closed only the 
Design Template of a repeating collection is saved to disk - the data 
it displays is not. 

Data may be exported/imported from/to databases and reports. Then 
are three data transport methods that are supported. 

The Clipboard format: 

> This option allows you to export qualified records to or import 
suitably formatted information from the standard Macintosh 
clipboard. The data format is the same as for Text files, only the dat; 
is held in the clipboard. 



Details and Techniques 

The Text File format: 

> This option allows you to export/import records in text file 
format. Reflex separates each field in any text file with a tab 
character and ends a record with a carriage return. In the case of 
records which contain a Link, both the single-valued fields and the 
Key field copies inside the Link are separated by tabs - a single 
carriage return character marks the end of each record. 

For example: 

Field(tab)Field(tab)Link Key field(tab)Link Key field(tab)Field(cr) 

In the case of records which contain both single value fields and 
Link Collections, the format is a little different. Single-valued 
fields are separated by tabs and the last one is followed by a carriage 
return; each Link within a Link Collection is placed on a separate 
line with tabs separating Key field values and a carriage return at the 
end of each Link. The last Link of a Link Collection is ended with 
two carriage returns. 

The example below shows how a record that contains three single­
valued fields and a Collection of Links containing three Links might 
be exported: 

Field(tab )Field(tab )Field( cr) 
Link Key field(tab)Link Key field(tab)Link Key field(cr) 
Link Key field(tab)Link Key field(tab)Link Key field(cr) 
Link Key field(tab)Link Key field(tab)Link Key field(cr)(cr) 
Field(cr) 

The Mail Merge format: 

This option allows you to export/import records to or from a text file 
in a mail merge format. You will then be able to use the mail merge 
file with word processing programs such as Microsoft Word™ to 
produce personalized letters, circulars, etc. The only difference 
between this format and the standard text file format is that there is a 
header at the beginning of the file which lists the names of the fields 
that make up each record and certain text strings are delimited with 
quotes (eg: empty fields, and fields with embedded commas). Refer 
to the Microsoft Word user manual for more specific information on 
how to make best use of this feature. 
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To export all database file records: 

All or just some records may be exported from a database file. 

> Open the relevant database file and select Export Records from the 
Misc menu making sure that there is no Record Qualification in the 
fonnula panel. A dialog will appear asking that you specify the 
export fonnat. You may choose from the three options described 
above. Next, another dialog appears requesting that you specify the 
fields from which to export data. Select each relevant field and click 
on the Include button (to include all fields, just click on the Include 
All button). If you are exporting to the clipboard, Reflex will 
proceed with the export procedure. If you are exporting to a text or 
mail merge file, you will be asked to provide the file name. 

Exporting Information from a subset of a Database: 

> Open the relevant database file. Enter a Record Qualification in 
the fonnula panel (you may use the First, Last, Next, Prior Record 
commands to verify your record selection). Then proceed with the 
record export as detailed above. 

Exporting Information from Report Fields (outside of all 
repeating collections): 

> Make sure that no repeating collection is selected. Invoke the 
Export Data option in the Report menu and a dialog will appear 
asking that you specify the export fonnat. You may choose from the 
three options described above. Next, another dialog appears 
requesting that you specify the fields from which to export data (the 
list will only contain the names of fields not contained in any 
repeating collection). Select each relevant field and click on the 
Include button (to include all fields, just click on the Include All 
button). If you are exporting to the clipboard, Reflex will proceed 
with the export procedure. If you are exporting to a text or mail 
merge file, you will be asked to provide the file name. 

Exporting Information from Repeating Collections: 

> Select the relevant repeating collection by clicking on it. Proceed 
as above, but be aware that the export field list will only contain the 
names of the fields contained within the selected repeating 
collection. 



Printing 

Details and Techniques 

In other words, you may only export data from the fields within a 
single repeating collection at a time. The chosen fields will be 
exported for all records in that repeating collection, no matter if they 
are nested under different repeating collections. 

Note: A useful feature of Reflex is that report data may be used to 
create new database files or update the information in existing 
database files. See Example 7 for a description of how to use report 
data to update the records information in an existing file. 

The Overview: 

> You may produce a hard-copy version of a database design (for 
documentation purposes or whatever) by printing the file images 
displayed in the Overview window. Simply make the Overview 
window active and select the Print option from the File menu. Be 
aware that all file images available in the Overview window (not just 
those visible) will be printed. 

Database Records: 

> You may obtain copies of individual database records by selecting 
the Print option from the File menu when the relevant record is 
displayed in the active data entry window. 

To print Report designs: 

> Open a report window and make sure that the activity indicator 
reads "Report Design". Select the Print option in the File menu. 
Fields and repeating collections will be printed in their box-like 
design appearance. You will only be able to obtain a print-out of the 
design template and not the data produced by a repeating collection. 
Special objects such as Page Break icons are also printed. 

To print Report data: 

> Open a report window and make sure that the activity indicator 
reads "Report Display". Select the Print option in the File menu. The 
data contained within a repeating collection will be printed as 
appears on the screen. Although repeating collections and field 
boxes are visible on the screen in display mode, their box-like 
borders will not be printed. 
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Note: Objects (a label a picture, for example) below a repeating 
collection in a report design float down in the report display to 
maintain the same distance beneath that repeating collection. Objects 
below multiple repeating collections float down to keep the same 
distance from the longest repeating collection (the repeating 
collection that reaches farthest down the report). 

Headers and Footers are printed only for reports printed in display 
mode. Headers are printed at the top of every page except the first 
page (so that the header does not conflict with column headings, for 
example). Footers are printed at the bottom of every page. 

Before printing, the heights of all headers and footers are inspected 
and enough space is reserved at the top and bottom of all pages top 
accommodate the largest header and footer. The report as a whole 
and any repeating collection can have a header and/or a footer. 

When a page break occurs, the top or bottom page break line can cut 
across repeating collections. If the top/bottom page break line does 
not cut a repeating collection, then any existing header/footer of the 
report is used. If the top/bottom page break line cuts across one or 
more repeating collections, the header/footer of the innermost 
repeating collection(s) that define a header is used. With side-by­
side repeating collections, two or more headers/footers may be 
printed. 

To create a overall Report Header/Footer: 

> Make sure no repeating collection is selected. Select the Show 
Header or Show Footer option from the Report menu. An empty 
header/footer box will appear. Only one header or footer can be 
displayed at one time. 

While a header or footer is displayed the report undeneath it cannot 
be edited. A header can only contain labels and pictures and these 
are created in the same way as in the rest of a report. However, if 
the special strings "[page]",and "[date]" (without quotes) are 
included in a label, all occurences of these strings will be replaced 
by the current page and date in the printout. (These values are 
obtained from the Macintosh clock/calendar). When a header is 
printed, its top edge is placed up against the top of the page and the 
height of the header is measured from its top edge. When a footer is 
printed, its bottom edge is placed up against the bottom of the page 
and the height of the footer is measured from its bottom edge. 



Keeping Objects 
Together On the 
Printed Page 

Details and Techniques 

The Show Header option in the Report menu changes to Hide 
Header when it is selected. The same goes for Show Footer. 

To create a Header/Footer for a Repeating Collection: 

> Select the relevant repeating collection and then follow the same 
procedure as above. 

To select a Header/Footer: 

> Select the Show HeaderIFooter option from the Report menu. 
When the object appears, move the cursor close to its top or bottom 
edge - notice that the crosshair cursor changes to an arrow shape 
when correctly positioned. Press the mouse button and move the 
object up or down as desired. Note that the location of a header has 
no effect on where the header will be printed. 

To remove a Header/Footer: 

> To remove a header/footer from a report or repeating collection 
simply show the header/footer (it will automatically be selected) and 
use the Clear option in the Edit menu. Alternatively, just select the 
current header/footer as described above and use the Clear option. 

> The No Page Breaks icon: To create a No Page Breaks icon: 
Make sure the report window activity indicator reads "Report 
Design". Draw a thin vertical black box as high as the object(s) you 
wish to keep together and then select the No Page Breaks option 
from the Describe menu. This icon attempts to keep the objects to its 
left/right together on the same printed page. 

Note: The No Page Breaks icon expands in report display to keep 
its top and bottom aligned with the tops and bottoms of the objects 
to its left and right. Remember that Page Break icons are not printed 
in report display. 
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> Page Break Before Icon: To create a Page Break Before 
Icon: Make sure the report window activity indicator reads "Report 
Design". Click down on the report to create a small black box. 
Select the Page Break Before option from the Describe menu. This 
icon ensures that a page break occurs at the top edge of the icon in 
the printed report. 

> Page Break After Icon: To create a Page Break After Icon: 
Make sure the report window activity indicator reads "Report 
Design". Click down on the report to create a small black box. 
Select the Page Break After option from the Describe menu. This 
icon ensures that a page break occurs at the bottom edge of the icon 
in the printed report. 

Note: Page Break icons float down in report display to keep both 
below anything that was above them in the design and aligned with 
anything that was to the left and right. 

> To halt a range of time-consuming operations (searching for 
database file records, calculating reports, exporting/importing 
information, printing, etc ... ) simply hold down the "00" key and 
then press the period (".") key. 



EXAMPLE 1: 
Changing The 
Key Type of a 
Database File. 

Details and Techniques 

This example shows you a simple method of converting the key of a 
database file from one design (lastname and firstname) to another 
(employee number). The database shown below is used. 

El NewKey 

LastName 
FirstName 
Tel# 
Employer 

To Change from the LastName/FirstName key to an 
Employee Number Key: 

> Select the complete file image or the last field in the file image. 

> Go to the Overview menu and select the Insert Field option. 

> Enter a new field called EmployeeNumber and use the relevant 
Describe menu option to make it a Sequence or Integer field. 

> Save the modified database file design (shown below) and then 
open it by double-clicking on its name bar. 

El NewKey 

EmQloyeeNumber 
LastName 
FirstName 
Tel# 
Employer 

> Enter employee numbers for each existing employee record. 

> Close the database and return to the file image in the Overview 
window. 
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> Select the EmployeeNumber field by clicking on it and move it 
above all other fields - it will automatically become a Key field. 
Select the LastName and FirstName fields in tum and use the Non­
Key Field option in the Describe menu to make them non-key fields. 

Note: If you use an Integer field for the Key, you will have to 
manually enter employee number values for each existing record and 
for each new record as it is filled out. On the other hand, if you use 
a Sequence field, you will only have to provide values for those 
records that already exist - new records will be automatically given a 
"highest existing number plus 1" value. 

Reordering field names in the file image does not automatically 
reorder the fields in the associated data entry form. Use the Form 
Layout option in the Database menu to modify the data entry form as 
you wish. 

This example shows you how to split the contents of a single 
database file field (eg: "Barbara, Jackson") into two separate fields 
(Lastname = "Barbara" and FirstName = "Jackson").The database 
file shown below is used. 

EJ SlngleName 
Name 
Address 
City 



Details and Techniques 

A record from this database would appear as: 

It File Edit Format Describe Database Search Misc Window 

SingleName 

II 

To split the Name field into a LastName and a FirstName 
field: 

> Select the SingleName file image. 

> Go to the File menu and select the New Report option. 

> When the report dialog appears asking you which type of report 
you wish to create, select the first option - a Table-Style report on 
"SingleN arne". 

> When the fields to report on dialog appears, select and include all 
the fields except for the Name field. 

> Next, the QueryBuild dialog will appear. Click on the Find All 
button since you want to modify the contents of all existing fields. 

> Provide a name for the new report -let's call it NameConvert. 

> When the report appears, it should appear something like the one 
below (of course the data will differ, depending on the records in 
your database file): 

It File Edit Format Describe Report Fonts Style Window 

NameConuert 
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> Next, add two fields called LastName and FirstName inside the 
repeating collection. 

> For the LastName field enter the following fonnula in the formula 
panel: 

MID(Name,LOCATE(Name,", ")+2,LENGTH(Name)) 

This formula uses the MID and LOCATE functions to "strip out" all 
the text that appears after the comma that separates the first name and 
last name in the single Name field. 

> For the FirstN arne field enter the following fonnula: 

MID(Name,I,LOCATE(Name,", ")-1) 

This formula uses the MID and LOCATE functions to "strip out" all 
the text that appears before the comma in the single Name field. 

> Calculate the new report with the 00= shortcut. 

• File Edit Format Describe Report Fonts Style Window 

:0 NameConuert 

~ II 
Last Name First Name ......................... ~.?~.~.~.~.~ ........................................... :.~.~.~ ..................... Q 

II~ackson lBarbara f041 Hemlock Ct. ISan Francisco l""': 
i 1~~~E~:~=:~::~]c.~r:.j~X~~F~~~_·'""":·' ·i942·H~;;d~~'Sr""·"'·""rL~~'G'~t~~'·"'""""'·" ~~ 

> Now you'll need to create a New DataBase File in the Overview 
window that has the desired LastNamelFirstName Key fields, as 
shown below: 

LJ LastFirstName 
LastName 
FirstName 
Address 
City 



Details and Techniques 

> Return to the N ameConvert report and select the repeating 
collection and then select the Export Data ... option from the Report 
menu. Decide whether you want to export the data to the clipboard 
or a text file (you will be asked to provide a name for the text file). 

> After selecting the Export format, you will then have to specify the 
order in which the fields should be exported from the report. In1cude 
LastName, FirstName, Address, and City. 

> Open up the new LastFirstName database file. Go to the Misc 
menu and select the Import Records option and then indicate where 
the records to be imported can be found (the clipboard or a text file 
in this case). 

> Finally, select the order in which the import fields should be 
entered into the LastFirstName database file (LastName, FirstName, 
Address and City). Reflex will now import all the records and you 
will have a new database with records that appear as below: 

• File Edit Format Describe Database Search Misc Window 

199 



EXAMPLE 3: 
Linking Single 
Reflex or "Foreign" 
Database Files 

200 

It is very easy to link the records in two independent database 
whether they were created within Reflex or imported from another 
application. The two database files shown below are used for this 
example. 

Ljcompany 
Name 
Address 

Lj Person 
Name 
Salary 
WorksFor 

> The first thing you have to do is enter a Link name in each file 
image and draw a Link line between them. Insert the Link names 
shown below: 

~Company 

Name 
Address 
Employees 

~ Person 
Name 
Salary 
WorksFor 
theCompany 

> Next, draw a Link line between the two Link names. Set the 
Employees as A Collection of Links to "Person" Records. Ensure 
that theCompany remains A Link to One "Company" Record. 

~company ~ Person 
Name Name 
Address Salary 
Employees 

---------
WorksFor 
theCompany 

> Open up the Person database file and export the Key field (Name) 
and the "linkage" field called W orksFor. 



EXAMPLE 4: 
Renaming & 
Deleting 
Database Files in 
the Finder 

Details and Techniques 

> Reimport the data back into the Person file, only this time import 
the Works For values into the new Link field called theCompany. 
Interlace will automatically copy the Name Key and the new values 
in theCompany over to the Collection of Links in the relevant 
Company records. 

> The records in these two files are now linked and you can delete 
the original W orksFor field since its values exist in the 
Employee/theCompany Link pair. 

lj Company lj Person 

Name Name 
Address Salary 
Employees the Company 

If you rename a database file at the Finder level, Reflex will not be 
aware of this. This can lead to problems when you try use a file or a 
set of files that used to be linked with the renamed file. 

To make Reflex aware of a renamed file: 

> When you try and Show Linked File (or make changes to a 
database file that has Links to other files) and Reflex cannot find the 
previously linked file, it will display the following dialog: 

Database File "topic" couldn't be found. I f you 
haue deleted" topic" in the Finder, please see 
Details 6' Techniques in the RefieH manual. If 
you haue renamed "topic" please enter the new 
name and select "rename." 

I subHeading 

(( Cancel )) 

(Rename) 
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In the previous example, Reflex could not find a file called "topic" 
which was part of a linked set . If the file has been renamed at the 
Finder level, simply enter the new name (subHeading) in the text 
box provid~d and click on the Rename button. 

To "clean up" after deleting a database file with Links to 
other files: 

If you have deleted a database file with Links in the Finder you must 
remove any Link "remnants" that exist in the remaining database 
files. To do this: 

> Show the image of each file that contained Links to the deleted 
file. 

> Select the now useless Link names (they will still be in bold type) 
and select the Clear option in the Edit menu. 

> Reflex will display the Rename dialog box. Just click on the 
Cancel button. 

> Now, Reflex will display the following dialog box: 

The Linked Database File is not open in the Ollerlliew 
window. Use the Show Database file ... command to show 
that file before attempting to clear this Link field. 

HOWEUER, if the Linked Database file NO LONGER EM I STS, 
you may choose Destroy Link. If you do this, you will 
DELETE RLL DRTR fOR THIS LINK. 

I( Cancel )1 

Destroy Link 

Note: If this Link is also a key, this dialog box won't appear, and it 
won't be possible to destroy the unconnected Link. 

Read the dialog text carefully, then click on the appropriate button. 

> If you click on the Destroy Link button, Reflex will delete the 
Link and the data it contains. You must then save the modified file 
design(s). 



EXAMPLE 5: 
Creating Field 
Qualifications 

EXAMPLE 6: 
Placing Pictures 
In Data Entry 
Forms & Reports 

Details and Techniques 

To create a field qualification, the active window must be a data 
entry Form Layout window. 

> Select the field you wish to enter a qualification for. 

> Enter the qualification formula - this qualification may be as 
simple or as complex as you wish. 

Th~ example shown below will only allow part numbers beginning 
with the number" 1 " to be entered in the Part# data entry field. 

• File Edit Format Describe Layout Fonts Style Wil 

o PartShipments 

PartName i i :. ......................................................................... : 

Placing pictures in Reflex data entry forms and reports can greatly 
enhance their appearance and usability. 

We start off, below, with a straightforward spreadsheet-style report 
that uses Reflex's PMT (payment) function to calculate the payments 
that have to be made on any loan. The parameters are: the amount 
owed, the annual interest rate, and the payment periods. 

P~[M~;~~~~-~~~~~il::\\~-l!~~r~!----·· .................... · .. i 
P.=:.:J=- Tot.l p.ymenL~~~~;~~i~lHHH I 

"R"~~d~t "D~:~;"g~" ki"" :Iilililililililililililililililililililililililililiiililililililililililililililililililililililililililililillli"(; ~ 
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By placing a picture into the report (as described in this section 
under Placing Pictures in Data Entry Forms/ Reports) and 
moving the fields around a little, a completely different visual effect 
can be given. 

PaymentSchedule 

. ... ...................................................................... . ... 

This is a simple graphic placed into a report. You can, of course, 
create pictures of the documents that you already use and paste them 
into data entry forms. 



EXAMPLE 7: 
Bulk Updates of 
Database Fi Ie 
Records 

Details and Techniques 

Rather than browsing through a whole database and changing every 
record (to give everyone a 10% raise, for example), you may create 
a report on a database that modifies one or more record values. 
These new values can then be exported from the report and then 
imported into the original database or a completely new database. By 
only reporting on a subset of a database file (producing a report only 
on those people with a particular job title, for example) you may do 
selective bulk updates of record information. 

To give everyone in the employee database shown below 
a 10% raise: 

Ej Employee 

Last Name 
Fl rstName 
JobTltle 
Sal ary 

> Create a table-style report on the Employee database - including 
only the LastName, FirstName and Salary fields. 

> Give the Salary field the formula shown below: 

• File Edit Format Describe Report Fonts Style Wil 

§D EmployeeRaise 
Lj Salary Sol ory* 1. 1 

: LostNome FirstNome · . 
•••••••••••• ,. .............. ", ............................... ,. •••••••••••• A •••••••••••••• ", •••••••••••••• ,.. •••••••••••••• ". ••••• 

.. .. .. .. ...................................................................................................... · . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . 

When the report is recalculated all salary field values will be 
increased by 10%. 

> Export the values from the modified report in the same LastName, 
FirstName, Salary order. 

> Import the updated values into the original database file - Reflex 
will replace the old values with the new. 

Note: If Reflex comes across a Key that does not already exist in 
the database file it will create a new record with that Key and 
associated fields. 

205 





Section Four: 
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REFLEX 
FORMULAS & 
QUERIES 

DATA TYPES 

Text 

Reflex Formulas and Queries 

Reflex fields may one of seven distinct data types - Text, 
Number, Integer, Date, Time, Logical and Sequence. 
Label and Picture objects are used strictly for decoration. The user 
typically specifies the type of each object at the time of its creation 
via the Describe menu options. 

The two data types, Error and NA are used to indicate anomalous 
conditions; these are typically, but not always, generated by 
Reflex (see section on Functions). 

In addition to the range of values defined below, each of the seven 
major data types can have a defined blank (empty) value. The blank 
value for each type is used when no value is desired for a field. 

The Text data type consists of a variable number of characters from 
the Macintosh character set. This includes letters, numbers, 
symbols, and special foreign language characters. 

In Reflex, text that does not fit on a single line will be word­
wrapped according to the standard Macintosh definition of a word 
boundary. Long text strings placed in multi-line text fields will 
therefore appear as paragraphs; these paragraphs can be separated by 
the use of carriage returns placed between them. Text that is 
wrapped beyond the last line of a text field - and can therefore not be 
seen - is still counted as part of the current text object. To view the 
hidden text, simply make the text field larger using its resize box. 

· Text may be arranged as a single line .. 
· . . . . . . · . . . . . . · . . . . . . · . . . . . . 

Sometimes, text can be 
arranged in paragraphs. · . . . . . . 

· There are times when one 1 i ne will not ....... ..... . 
. Just use a carn age 

be enough - text wl11 be wrapped as return between 
. .......... . 

paragraph blocks. · necessary. 
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Any text included in formulas must be contained (delimited) within 
double quotes. Any double quotes in the text itself must be repeated 
twice to distinguish it from the actual text delimiters. 

Example 1: 

.. File Edit Format Describe Report Fonts Style UJir 

~D 

~fl 
eHample_report l 

"Text must be delimited with double quotes" 

..... ) ..... ) ... ITe.xt m~st b~ deli ~ite~ Wit~ dou~le q~otes .I ..... ) ....... 
· . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . · . . . . . . . . . . . ....................................................................................................... 

Example 2: 

.. File Edit Format Describe Report Fonts Style UJin 

~D 

~fl 
eHample_report § 

"Text must be .... deli mited .... with double quotes" 

....... ~ ....... ~ . ..ITe.xt m~st b~ "del~mite.d" Wi.th do.uble ~uote.s 1.. ..... 
· . . . . . . . . . . · . . . . . . . . . . · . . . . . . . . . . 

The Text Sort order is: A a B b C c ...... Z z 



Number 

Integer 

Reflex Formulas and Queries 

The Number data type consists of whole and fractional numbers 
represented in floating point format. 

• Reflex provides up to 15 decimal digits of precision. 

Example: 

" File Edit Format Describe Report Fonts Style I 

D eHample repo 

~ 

· .................. r.?'.~·.~·.~·.~·.~·:.~·.·.~·.~·.~·.~·.?'.~.~.~·.·.·.·.·.· .......................................................... :::: ........................... J . ~ ................. . 
· ...... : ....... : . ~. ffti?~tf;~ffiff~f1.f~;~:;~:;;~::;;;;:~:;;;::;:~:;;~;;:;;:;;;~\. ........ : ....... : .. 

. :. ................................................................................................................... ;. . . 

· ...... : ....... ~ ... r~.·~.·~.·~.·::.~:.~::.~·.::.::.:.·.:.·.:.·.::.::.:.·.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:".::.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:.'.:".::.:".:.J. ~ ....... ~ ....... ~ .. 

• Exponents in the range +308 to -324 may be used. Exponents are 
indicated by following a number with the letter "E" or "e" and the 
exponent value. 

The Number Sort order is: -1,0, 1,2,3 ... 9 

The Integer data type is actually a subset of the Number data type. 
An Integer is a positive or negative whole number up to 2 billion . 
(2,147,483,647 to -2,147,483,647 inclusive, to be precise). This 
data type exists because such values are used frequently and can be 
stored more compactly and computed more quickly than Numbers. 
Also, Integer fields will not accept entry of values that contain a 
decimal point - this can be used to prevent entry of fractions where it 
makes no sense (i.e. ".3 children"). 

The Integer Sort order is the same as the Number Sort Order 
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The Date data type consists of the month, the day, and the year 
expressed as integers and separated by the slash character ("!,,). 

• The Month is from 1 to 12 for January through December. 

• The Day is from 1 to 31 as allowed by the corresponding 
Month. 

• The Year is either expressed as from 04 to 99 for the years 
1904 to 1999, or as from 1904 to 2039. 

• Note that dates may be used in formulas, but only if they are 
preceded with the @ symbol (this makes them a date constant an 
thus distinguishes them from the division of three numbers). 

Example: 

• File Edit Format Describe Report Fonts Style Wim 

§D eHample_report § 

X f 1 IF(TODAV > @ 12/31/99,"New Century","Too Early") 

. . ,..---------------,: : : : 
....... ~ ....... ~ ... ITO.O Ear.ly I.~ ....... ~ ....... ~ ....... ~. 

. . . . . . . . 

(Note: The field in which the result of the above formula will appear 
must be a text field, not a date field since we are asking for one of 
two text strings to be displayed). 

Date Sort order examples are: 8/20/47, 2/13/48, 2/16/48, 
7/12/58, 12/16/58 .... 



Logical 

Time 

Reflex Formulas and Queries 

The Logical data type consists of a TRUE or a FALSE value or a 
YES or a NO value. 

YES is functionally equivalent to TRUE and NO is functionally 
equivalent to FALSE. 

Example: 

" File Edit Format Describe Report Fonts Style I 

o 
~f1 

eHample repo 

....... L ......... L...-IT_RU_E _________ ---II. ~ ....... L ....... . 

The Logical Sort order is: Blank, NO, FALSE, TRUE, YES 

The Time data type follows the 24-hour format and consists of 
hours minutes and seconds separated by the colon character (":"). 

• The Hour value may be between 0 to 24. 

• The Minute value may be between 0 and 59. 

• The Second value may be between 0 and 59 and is optional, with 
zero as the default. 

• Time values may be used in data entry and report formulas 
provided they, like Date values, are preceded by the @ symbol. 

The Time Sort order is: 01:00:00,02:00:00 ...... 24:00:00 
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FORMULAS & 
NAMES 
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The Sequence data type consists of an integer value that, for data 
entry, can be set automatically by Reflex to a unique value, or as 
desired by the user. 

• The first record in a database file will be given the default 
Sequence value of 1; the second record will be given the default 
value of 2, etc ... 

• The user may change a record Sequence field to any value they 
wish provided it has not already been taken by another record. 
Reflex will then ensure that the next record Sequence field will have 
a value of the largest Sequence value in the file + 1. 

• In reports, a Sequence field is just like an Integer field. 

The Sequence Sort order is the same as the Number and Integer 
Sort order. 

A Name consists of a leading letter character followed by zero or 
more letters, digits, underbar characters ("_"), or number sign 
characters ("#"). Reflex does not allow spaces in names that 
consist of more than one word. (The underbar character will 
automatically be substituted if you inadvertently enter any spaces in 
names while defining the name of a database file, a report, a field, a 
repeating collection, or a Link. Although Reflex allows you to use 
long, descriptive names they cannot be more than 32 characters in 
length. 

The name of a field is a simple formula that refers to the value of that 
field. The name of a Database file, a Link, or a Repeating 
Collection are collectively referred to as Sources. 

• You cannot use Reflex keywords - such as AND, OR, NOT, 
FROM, WHERE, and CALLED - as names. 

• You cannot use Reflex function names that have no arguments 
- such as TRUE, FALSE, INFINITY, TODAY, PI, NOW, NA and 
PREVIOUS - as names. 



NAME SEQUENCE 
FORMATS 

The 'OF' Format 

The Possessive 
Format 

I 

Reflex Formulas and Queries 

To refer to infonnation in linked database files or reports other than 
the one you are working with, a single name reference is not 
adequate. Instead, you must use a Sequence of Names. A 
sequence of names can use one of three equivalent fonnats. 

The word 'OF' can be used to separate the sequence of Names. 

Examples: 

netWorth OF thePerson 

symbol OF theCompany 

This Name fonnat requires that you place the possessive fragment -
apostrophe S ('S) - at the end of all but the last of a sequence of 
names - spaces are also still required between the words. Note that 
this fonnat requires that you put the names in the opposite order to 
that of the OF fonnat. 

Examples: 

thePerson's netWorth 

theCompany's symbol 

The apostrophe S is still required even if the name being referenced 
is plural and therefore already ends with an S. 

Example: 

theStocks's amount 
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The Dot Format 

QUERIES 
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The third Name format allows the user to simply use the dot 
character (".") instead of the apostrophe S. 

Examples: 

thePerson.netWorth 
theCompany.symbol 

Possessive format and dot format references are functionally 
equivalent in terms of the sequence in which names appear; they 
may be freely intermixed. 

The "OF" Name format can only be mixed with the the latter two 
formats where the Name sequence begins with OF and then 
switches either to the possessive or the dot fonnat. Once the 
possessive format or the dot format has been used in a Name 
Reference, you cannot switch back to the OF format. 

Example: 

MAX(netWorth of theStockholders.thePerson FROM company 
WHERE stockName = "Revstar") 

At its simplest, a query is just the name of a Source. 

Examples: 

Employee 
netWorth 
theStocks 

However, more selective views of Sources are made possible by 
providing a query that features the Source name, followed by a 
"WHERE", which in tum is followed by a Qualification. A 
qualification is just a formula that returns either TR VE or FALSE. 
The qualification can refer to the various data fields of a record by 
name and can include some comparisons. 

Example: 

Person WHERE netWorth < 200000 



The "Called" Option 

Reflex Formulas and Queries 

In queries involving more than one file, you will sometimes find that 
a field name in one file is the same as that of a field in another file. 
This is always the case when the query has to use the same file 
twice. 

Example: 

If the problem is to find the name of every stockholder that has a 
greater net worth than somebody called Smith, you can use the 
following design template. 

But what do you actually put in place of the ??? to refer to Smith's 
net worth? The answer is provided by the "Called" option which can 
be used to supply a synonym for the name Smith, as shown in the 
completed design template. 

(Jerson Called 8m ith 

WHER£ last Name =~'~b·.: ....................................... _ .. '..~2::.: ........ 1 
~:;:::r1~ ~E~!itb' s I L.·:.:.:::::.·.·:·.·:.·: .. ·:::.:·~:··~~.:·~~·.····~·:~~] I 
netWorth ......................................................................................................... . 

The Called option can be used with any Source, not just a database 
file as in this example. 
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A Function call typically consists of the name of a function followed 
by one or more parameters contained in parentheses and separated 
by commas. Some Functions - including PI, TODAY, NOW, and 
FALSE - do not require parameters (See the section on Functions 
for more specific information). 

• A function parameter is a formula. 

Example: 

ROUND(netWorth) 

• Some functions - including SUM, MAX, COUNT, and 
AVERAGE - accept an indeterminate number of parameters. 

In general the format is: 

A VERAGE(formula FROM query) 

A specific example is: 

A VERAGE(netWorth FROM person) 

This function will obtain the netWorth value from every person 
record and then compute the average of these values. 

• The COUNT function is a special case in that it can take a query 
as a parameter. 

The general format is: 

COUNT( query) 

A specific example is: 

COUNT(person WHERE city = "San Francisco") 

This example COUNTs the number of Person records that meet the 
qualification. 



FORMULA 
COMPONENTS 

Expressions 

Order of Evaluation 

Reflex Formulas and Queries 

An Expression is the combination of some basic elements - a text, a 
number, a reference Source name, a function or a parenthesized 
formula - and one or more operators. 

The arithmetic operators are: 

+ 

* 
/ 
A 

Addition 
Subtraction or Negation 
Multiplication 
Division 
Exponentiation 

All arithmetic calculations in Reflex can use either Numbers or 
Integers or both. Integers are automatically converted to Numbers 
when necessary. 

If several arithmetic operators are used in a single expression, the 
calculations are performed in the order: 

Negation 
A Exponentiation 
* or / Multiplication or Division 
+ or - Addition or Subtraction 

If you wish, a different order of calculation can be produced by 
using parentheses to group sub-expressions that are to be calculated 
first. 
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The Text Operator 
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There is one textual operator - the ampersand character ("&"). The 
ampersand can be used to concatenate text values, or text values and 
a number values. Reflex can convert dates, numbers and other data 
types to text as needed. 

For text to text concatenation the format is: "Text" & "Text" 

Example: 

Ii: File Edit Format Destribe Report Fonts Style U 

~D 

~fl 
StotkReport 

"John"&" Bradford" 

. . . 
. . . . . . . ~ ....... ~ ....... ~ .... "-IJ-~ h-n-B-~-a-d f-O-:d---', ....... ~ ....... ~ . .. .. .. . ...... ~ ....... ~ .. . 

· . . . . . . .. .. · . . . . . . .. .. · . . . . . . .. ., 

Database file fields may be concatenated in reports so that multiple 
fields appear as one field. The format is: 
Fieldname&" "&Fieldname ... 

Example: 

In this example, the values of the separate first and lastname fields 
(which have the formulas firstname and lastname, respectively) are 
concatenated in the field labelled "First & Last Name". The repeating 
collection is providing a view of the Person file. 

" File Edit Format Describe Report Fonts Style Window 

o StockReport 
~ f3 firstname&" "&lastneme 

First Name Last Name First & Last Name 

rM;;;'~'~''''''''''''''''''''''''''''''1 r~'~'ii;;;'~~"''''''''''''''''1 l'M;;;'~'~"'~'~if';:;:";;;';:;'"'''''''''''''''' I 



Comparison 
Operators 

Logical Operators 

Reflex Formulas and Queries 

A Comparison consists of one of the six following operators: 

= Equal 
< > Not Equal 
< Less Than 
> Greater Than 
<= Less Than or Equal 
=> Greater Than or Equal 

Numbers and Integers may be compared. Text objects may be 
compared using the standard Macintosh primary ordering of the 
character set. Dates and Times may also be compared. 

Examples: 

10 < > 50 
5 < 12 
IF(10*10 = 100, "Equal", "Not equal") 

Reflex provides support for the standard Logical operators AND, 
OR,NOT. 

Examples: 

amount> 100 AND pricepaid <50 

netWorth >100000 OR age >50 
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Formula ::= {Query FROM } Query 

Query ::= Qualification [CALLED Name] [WHERE Qualification ] 

Qualification ::= Negation { ( AND I OR) Negation } 
Negation ::= [ NOT] Comparison 

Comparison ::= Compound [ ('=' I '<>' I '<' I '>' I '<=' I '>=') Compound] 

Compound ::= Expression { '&' Expression 
Expression ::= Term { ('+' I '-' ) Term } 
Term ::= Power { ('*' I 'f) Power} 
Power ::= Factor { '/\' Factor} 

Factor ::= '''' Text' '" I Number I '@' (Date ,I Time) 
Logical I ['+' I '-'] (Reference I Function I '(,Qualification ')') 

Function ::= FunctionName [ '(' [ Formula { ',' Formula }] ')' ] 
FunctionName ::= ABS I ATAN I AVERAGE I CHAR I COS ICOUNT I 
DATE I DAY I ERROR I EXISTS I EXP I FV IHOUR I IF I INCLUDES I 
INFINITY lINT I ISERROR IISNA I LENGTH I LN I LOCATE I LOG I 
LOOKUP I MAXI MID I MIN I MINUTE I MOD I MONTH I NA I NOW I 
PV I PI I PMT I PREVIOUS I PV I REPEAT I ROUND ISECOND I SIN I 
SQRT I STARTS I STDEV I SUM I TAN ITIME I TODAY I YEAR 

Reference ::= Name [OF Reference I { (' 's' I ',' ) Name} 

Name ::= (letter I '_' I '#') {letter I '_' I '#' I digit} 

Date ::= Integer 'f Integer 'f Integer 

Time ::= Integer [':' Integer [':' Integer]] 

Logical ::= TRUE I FALSE I YES I NO 

Number ::= (Integer [',' {digit}] I ',' digit { digit} ) 
[ ('E' I 'e') Integer] 

Integer ::= ['+' I '-'] digit {digit} 

Text ::= {character} 

{ } 

[ ] 

Consists of 

Repeat as many times as 

Optional 

Or 



REFLEX 
MENUS 

The Overview 
Menu bar 

The Data Entry 
Menu bar 

Reflex Menus 

In addition to the standard Apple (ti) menu~ Reflex provides a range 
of main menus and menu options which change (are updated) 
according to the type of activity you are doing. Reflex menus are 
used in the standard Macintosh manner. Menu options that are not 
appropriate for the current activity will be dimmed (gray) and you 
will not be able to select them. 

The Database Overview menu bar is the first that appears after 
you load the Reflex program. It contains everything you will need to 
create new database files, show the images of existing database 
files, and modify existing database files. Reflex program 
information and Reflex's Help system can be obtained via the 
relevant options contained in the ti menu. 

The Data Entry menu bar appears when you open a database file 
for data entry. This menu bar contains everything you will need to 
enter, modify, and delete records. Records may be exported and 
imported with options in the Misc menu. 
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The Form Layout 
Menu bar 

The Report menu 
bar 
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The Form Layout menu bar appears when you choose the Form 
Layout option from the Database menu in the Data Entry menu bar. 
This menu bar contains everything you will need to customize your 
data entry forms. 

The Report menu bar appe~rs when you create a new report or 
open an existing report. This menu bar contains everything you will 
need to design, display and modify reports. 

The rest of this menu reference section is devoted to brief 
descriptions of the options found within each menu heading. 



APPLE MENU 

Help 

Rulers 
Chooser 
Scrapbook 
Hlarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 

Apple Menu 

I Ell File Edit Format Describe Report Fonts Style Window 

About RefleH ••• 
Help 

Control Panel 
Chooser 
Scrapbook 
Note Pad 

The • (apple) menu contains two Reflex specific options and a list 
of all available desk accessories. The list of desk accessories will 
vary depending on the number currently installed. (Use Apple's· 
Font/DA Mover™ utility program to install or remove desk 
accessories.) The two Reflex options - which provide program 
version information and access to Reflex's main Help facility -
cannot be changed by the user. 

The About Reflex option produces a dialog box giving copyright 
and program version information. Click the OK button to send the 
dialog away. 
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Rulers 
Chooser 
Scrapbook 
Rlarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
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Reflex's major Help function is available in one of two ways: 

• Select the Help option from the. menu: A Help window will 
appear which contains a range of choice buttons and an index of 
topics on which Help is available. Select the topic you need help on 
and click on the Show Topic button. 

-D Help 

( Show Topic ) ( Show ~ndeH ) ( Cancel ) ( 

Field Data Types 
... Date 
.. .Integer 

... Number 

... SeQuence 

.. .Text 

.. .Time 
Files 

Show Topic will display relevant Help text. 

II 

Show Index will return you from within a particular topic to the 
main Help Index to make another choice. 

Next and Previous move you within individual Help topics. 

Cancel returns you to Reflex. 



Apple Menu 

• To get an explanation of almost any item on the screen or any 
menu command, simply hold down the 00 key and press the 
question-mark ("?") key (it doesn't matter if you use the Shift key or 
not).The arrow cursor will tum into a large question mark. A 
description of almost any item or menu command can be obtained by 
placing the question mark cursor over the particular item and 
clicking the mouse button once. The Help window, as described 
previously, will appear and display the explanation you seek. 

Personlnfo 

II 
Enter Data 

Note that this latter form of Help cannot be used with dialog boxes -
they are either self-explanatory or have their own Help feature (as 
with the QueryBuild dialog). 
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FILE MENU 

228 

. Edit Format Describe Report Fonts Style Window 
New Database File •.. 
New Report •.. 
Open Database File •.• 
Open Report .•. 
I: !OS(~ 
Close All Documents 
Saue Design 3CS 
S<WH fI~,,, 
Reuert to Old Design 3CR 

Page Setup •.. 
Print •.• 

Quit 

The File menu is where you design, save, open and close the 
various types of Reflex documents that you will create. This menu 
also has an option that allows you to revert the design of database 
files and reports, and the contents of database records, if for any 
reason you do not wish to keep the modifications you have made. 

Standard Macintosh Page Setup and Print options are included. 
The last menu option - Quit - returns you to the Finder. 



New Report ••• 
Open Database File ... 
Open Report ... 
Close 
Close RII Documents 
Salle Record XS 
Salle Rs ... 
Rellert to Old Re~ord XR 

Page Setup ... 
Print ... 

File Menu 

The New Database File option is selected when you want to 
design a new database file. Reflex responds by displaying a 
standard file dialog requesting that you name the new file. 

• Entering a name and clicking on the Create button causes a blank 
file image to appear in the Overview window. Its name bar contains 
the name you supplied. If the name has already been taken, Reflex 
will ask you if you wish to replace the existing file. Make a decision 
and click the required button. 

• If you change your mind and decide not to go ahead with building 
a new database file just click on the Cancel button and the standard 
file dialog will disappear. 

You may preselect where Reflex will place a new file by dragging 
diagonally in the Overview window with the mouse button 
depressed. A black box will appear as a location marker. If you do 
not preselect a spot, Reflex automatically places the new file in the 
Ov'erview window along the left margin, below the lowest file 
currently visible. 

The New Database File option is always available from the File 
menu regardless of what you are doing within Reflex. 
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I ••• 

Open Database File ••• 
Open Report ••• 
I: los(~ 
Close RII Documents 
Saue Design ses 
S<W(~ fl~,,, 

Heuert to Old Design seH 

Page Setup ••• 
Print ... 

Quit 

230 

The New Report option is selected when you want to design a 
new report. Selecting this option produces a dialog box which offers 
a selection between a ready-made table-style report and a report 
which you design yourself. 

• Table Style Report on the currently selected database or another 
database you choose: This is the quickest way to produce a simple 
columns and row sty Ie report on a single database. You can 
customize both the layout and the contents of the record list via the 
Design Report menu option in the Report menu. Record 
qualifications entered directly into the formula panel or via 
QueryBuild can be used to restrict the records that are displayed. All 
table-style reports can be redesigned to work with multiple files. 

• A report which you design yourself: Custom reports may be as 
simple or as complex as you wish - there is no initial default format 
as with table-style reports. Report form layout is entirely up to the 
individual user's taste or requirements. 

In all reports: Fields can be created, positioned and repositioned, 
text labels may be created and displayed in different fonts and font 
styles, and pictures can be pasted in via the clipboard. 

A most powerful feature of reports is Reflex's formulas and queries 
which can be used to produce reports of an unusually complex 
nature. 



New Database File ... 
New Report ... 
II· I •• 1 •• 

Open Report ..• 
I: !!)S(~ 
Close All Documents 
Saue Design 8€S 
S<n~(~ Hi-H' 

Reuert to Old Design 8€R 

Page Setup ••• 
Print •.• 

Quit 

File Menu 

The Open Database File option is used to open up a data entry 
form for an existing file. The file may already contain data or it may 
have just been created and must now be opened for initial data input. 

There are two methods of opening an Reflex file: 

• If the Overview window is not active, go to the File menu and 
select the Open Database File option. When the standard file dialog 
appears, select the file name that you wish to open and click on the 
Open button. The data entry form will open for that database and 
you may add, edit or view the records it contains. 

• The fastest way to open a database is to double-click on its name 
bar (but not its status icon) just as you would open a program or 
document from the Finder. 

The first option allows you to stop the open database file procedure 
with a Cancel button, the second clearly does not. Many database 
files can be open at one time. 
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New Database File •.. 
New Report •.• 
Open Database File ••• 

I. I 

[ los(~ 
Close All Documents 
Salle Design 88S 
S<Hl(~ fl~ ... 
Reuert to Old Design 88R 

Page Setup ••• 
Print ... 

Quit 

New Database File ... 
New Report ... 
Open Database File ... 
Open Report ... 

I • 

Close All Documents 
Salle Record 31:5 
Salle As ... 
ReLlert to Old Record 3I:R 

Page Setup ... 
Print ... 

Quit 
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The Open Report option allows you to open up an existing report 
form for calculation or modification. This is the only way you can 
do this since report forms do not appear in the Overview window 
and can therefore cannot be double-clicked. Many reports can be 
open at one time. Note that calculating a specific report will open 
any reports that it refers to and will show the images of all database 
files referenced in the Overview window. 

If you are working anywhere other than in the Overview window, 
the Close option closes the currently active window. If changes 
have been made to the current database file or report, the Close 
function saves them to disk automatically. Close is not available (it 
is grayed) when the Overview window is active. You can, of 
course, use the close box on each window to remove an active 
window. 



New Database File ••. 
New Report ••• 
Open Database File ••• 
Open Report ••• 
Close 

Salle Record _S 
Salle 8s ••• 
Rellert to Old Record _R 

Page Setup ..• 
Print ••• 

Quit 

New Database File ... 
New Report ••• 
Open Database File ••• 
Open Report ••• 
[Ios(~ 

Close 811 Documents 
•. I· I 

S<HI(~ fI~", 

Rellert to Old Design 38R 

Page Setup .•• 
Print. •• 

Quit 

File Menu 

The Close All Documents option closes all active database file 
and report windows and saves any unsaved changes. This is a 
useful feature if you have to close a number of database documents 
in order to make modifications to their structure in the Overview 
window or you just want to clear everything away quickly. Close 
All Documents does not have any effect on the Overview window. 

The Save Design option reads differently (it is updated) depending 
on the activity you are doing. It can be one of four possibilities: 
Save Design, Save Report, Save Record, and Save Form. 

• Save Design is used to save the design of new database files or to 
save changes to existing files. This option may be selected at any 
time to save changes to files. New database file designs are 
automatically saved when you try to open them the first time. Save 
Design must be used to save all changes to an existing database file 
structure before it can be opened. 

• Save Report is used to save the design of a report you have just 
created or the modified design of an existing report. 

• Save Record places the current record into the file to which it 
belongs. This command also writes all changes made to disk so that 
the disk copy of the file is as accurate as possible. 

• Save Form is used to save the design of a Data Entry Form you 
have just customized. 
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New Database ••• 
New Report ••• 
Open Database ••• 
Open Report .•. 
Close 
Close 811 Documents 
Salle Record 38S 
Salle As... ~ 

ReLlert to Old Record 38R 

Page Setup ••• 
Print .•. 

Quit 

New Database File ••• 
New Report ... 
Open Database File .•• 
Open Report ••• 
I: !OS(~ 
Close RII Documents 
Salle Design 38S 
S<ItI(~ fli> '" 

I 1 I I' I 

Page Setup ... 
Print ... 

Quit 
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The Save As option is used to make copies of existing database 
files or reports under another name on the current or some other 
disk. The original file is left untouched, but its design and contents 
are duplicated and saved under the new name. This is useful if you 
run out of disk space since you can use the standard file dialog Eject 
button to remove the current full disk and replace it with a blank 
(formatted or unformatted) one. You cannot copy a file from the 
Overview window - its database window must first be opened. It is 
important to note that it is not good practice to make multiple copies 
of the same database other than for backup purposes since this can 
lead to inconsistent data. Reflex will display an error message if you 
try to open more than one version of a file at the same time and the 
original file contains Links. 

Often, you will wish to undo changes you have made to a database 
or report - this is where the Revert option comes in really handy. 
This menu option changes to keep track of whatever activity you are 
doing. There are four possibilities: Revert to Old Design; 
Revert to Old Report; Revert to Old Record, and Revert to 
Old Form. 

• Revert to Old Design: This option will discard all changes you 
have made to the current database file image and reload the last 
saved version. Be careful, if you save any changes to disk and then 
change your mind, Revert to Old Design will not be able to help you 
at all and you'll have to manually recreate the desired file or 
structure. 

• Revert to Old Report: This option will discard all changes you 
have made to the current report and reload the last saved version of 
the report. 

• Revert to Old Record: This option will discard all changes to the 
current database file record and redisplay the last version inserted 
into the file. If the record is new (unsaved), using the revert 
command will return the record to its original blank state. 

• Revert to Old Form: This option will discard all changes to the 
current data entry form and redisplay the last saved version of the 
form. 



New Database File ... 
New Report ... 
Open Database File ... 
Open Report ... 
I: lns(~ 
Close HII Documents 
Salle Design ~S 

S<W(~ f1~", 

ReLlert to Old Design ~R 

File Menu 

The Page Setup and Print options provide access to standard 
Macintosh page size/orientation and printing dialogs as shown 
below: 

When the Page Setup dialog appears, just select the options you 
wish by clicking on the relevant button(s). 

I mageWriter (Standard or Wide) I( OK 
Paper: @ US Letter 0 R4 Letter 

)1 

o US Legal 0 International Fanfold ( Cancel) 
o Computer Paper 

Orientation: @ Tall 0 Tall Rdjusted 0 Wide 

Pagination: @ Normal pages 0 No breaks between pages 

Reduction: @ None 0 50 percent 

The Print dialog allows you to select the quality of printed output, 
the specific pages to print, the number of copies of the document, 
and the type of paper (continuous or cut-sheet) that will be used. 
Both the Apple Imagewriter and LaserWriter are supported. 

I mageWriter (Standard or Wide) I( OK )1 
Quality: 0 High @ Standard 0 Draft 

Page Range: @ RII 0 from: D To: D 
copies: 0 

( cancel) 

Paper Feed: @ Continuous 0 cut Sheet 

For a more detailed explanation on these two menu options refer to 
Macintosh™, the owner's manual. 
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New Database File ... 
New Report ... 
Open Database File ... 
Open Report ... 
I: !OS(~ 
Close RII Documents 
Salle Oesign 3€S 
S<Ul(~ fh", 
ReLlert to Old Design 3€R 

Page Setup ... 
Print... 

236 

The Quit option is used to exit from Reflex. 

• If there are no unsaved changes to database files in the Overview 
or any open documents, this option simply returns the user to the 
Finder. 

• If there are unsaved changes to documents the Quit option saves 
them, if possible, and then exits to the Finder. 

• If there are unsaved changes to file images in the Overview, you 
are asked whether you want to save them. You may save the 
changes and continue with the Quit. You may cancel the changes 
you have made in the Overview and continue with the Quit. Lastly, 
you may opt to return to Reflex. 

[ 

There are new and/or changed Database 
Files in the Oueruiew. Do you want them 
saued? 

Saue Changes J 
Cancel Changes 

[Return to Interlace) 



EDIT MENU 

cut 38H 
Copy sec 
Paste 38U 
Clear 
Duplicate 380 

Paste Function Name 
Paste Qu 

Cut 8€H 
Copy 8€C 
Paste :~w 

Clear 
Duplicate :·;n 

Paste Function Name 
Paste Que 

Edit Menu 

The Edit menu contains all those options you will need to 
manipulate objects while using Reflex. There are options to Cut, 
Copy, Paste, Clear, and Duplicate objects. The last two 
options, Paste Function Name and Paste Query, are used to 
place functions and queries in the formula panel of the active 
window. 

The Undo option is used to discard all changes made as a result of 
choosing the cut and paste options listed below it in the Edit menu 
(or when you select objects and then use the Backspace key 
shortcut). If you enter text in a database file or report field or 
formula/name panel, and then wish to remove that text, you may 
choose the Undo option. If the text area in question was previously 
empty, it will become empty once again. If the text area already 
contained text which you overwrote or edited, that text will 
reappear. 

Be careful, Undo will only reverse the last action you did - you 
cannot rely on it to bring back items modified or deleted early in a 
work session. 

If Undo is not applicable or not available for some reason the option 
will appear gray and you will not be able to select it. 
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Undo ~2 

Copy ~C 

Paste ~U 

Clear 
Duplicate 000 

Paste Function Name 
Paste Query 

Undo 

Cut 
II 

Paste 
Clear 
Duplicate 

~2 

agH 

agU 

agO 

P!~s1(~ fun!;Hon NanH~ 
P!~s1 (~ {!U(~qJ 
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The Cut option is used to delete what is currently selected from the 
current database or report and place it in the Macintosh Clipboard -
anything already in the clipboard will be discarded. 

• In a data entry form or report, you can select a single object, or 
multiple objects, to cut and paste. The contents of any field that is 
Cut (its value, formula, name, type, formatting, current font and 
style), are included in the Cut. 

The Copy option makes a duplicate of any currently selected object 
or group of objects and places the duplicate in the clipboard. 
Anything placed in the clipboard in this way can be pasted into any 
other Interlace document. 

The Copy feature is useful when transferring items between the 
various Interlace documents you will be working with. 

• Copying fields copies everything about that field, enabling you to 
save development time when designing very similar forms. 

• Copying forml,llas, especially long and complex ones, is a much 
safer way of transporting them between documents than retyping. 



Undo 

Cut 
Copy 

Clear 
Duplicate 

88H 
88C 

Edit Menu 

The Paste option can be viewed as the companion option to Cut and 
Copy. It is used to insert the contents of the clipboard into the 
currently selected target. The clipboard contents may orginate from 
within Reflex itself or from other applications or desk accessories 
such as the Scrapbook. 

• Text can be pasted into name and formula panels when those 
880 panels can be edited. 

Pas1(~ run~:1ion N!~nH~ • Text can be pasted into fields and labels when these objects can 
Pas1e OlH~qJ be edited. 

• Text and Picture objects (and multiple selections of these objects) 
can be pasted into Headers, Footers, and Data Entry Forms. 

• All objects, and multiple selections of them, can be pasted into 
Reports. 
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Cut 88H 
Copy 88C 
Paste 88U 

Duplicate 880 

P~~s1 (~ hmtHon NanH:> 
P~~s1 H (!lH~1 
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The Clear option, while similar to the Cut option, does not place 
any selected items into the clipboard - it simply discards them. 

• In the Overview window you can use Clear to discard a new 
database file image that has not yet been saved and to remove new or 
existing file image fields. Removing an existing file image field 
would be a major change to a design and would therefore require 
that you save the changes before opening that file once again. The 
contents of any field that is deleted via the Clear option in the 
Overview window are lost, as indicated by the dialog: 

I f you delete this field you will lose all the data for 
that field. You can choose Reuert to Old Design in 
the File menu to undo all changes to the design. 

n OK 1 
cancel) 

• In Form Layout windows you can remove labels, pictures, and 
the contents of the formula panel (or multiple selections of these 
objects), by clicking on them and choosing the Clear option. 

• In report windows you can remove fields, labels, pictures, 
repeating collections, and the contents of the formula panel (or 
multiple selections of these objects) by clicking on them and 
choosing the Clear option. You can also use Clear to remove the 
contents of the name panel in a Report window, but you cannot then 
leave the name panel empty. If you attempt to do this, you will see 
the following dialog: 

[ OK 

Illegal name: all names must begin with a 
letter. 

J 



Cut 
Copy 
Paste 
Clear 

Edit Menu 

The Duplicate option is used to copy a selected item, or group of 
8€2 items, without placing the object(s) in the clipboard. Use it to create 

multiple fields of the same size and type within reports or to 
8€H customize reports with labels and graphic images. First, select the 
8€C field, repeating collection, label or graphic image and then choose 
8€U Duplicate. 

• Database fields cannot be duplicated with this option. 
!>as1H run~;Hon Nnm~~ 
!>ns1(~ OU(~1 • Duplicates are placed immediately below the original item. If ther 

is no space to do this (other fields are too close, for example), 
Reflex will first sound a beep. On a second attempt to use the same 
command Reflex will respond with the dialog: 

Objects in a form may not ouerlap. 

OK J 

If you still wish to duplicate the item in question, move it to where 
there is more space or reposition the object that blocks the way. 
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Undo 

Cut 
Copy 
Paste 
Clear 

3€H 
3€C 
3€U 

Duplicate 3€D 

.. . 
Paste Query 
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The Paste Function Name option allows you to obtain a dialog 
box listing all the possible functions that can be used to construct 
fonnulas. Each function appears within a standard dialog box 
button - to select a function you simply click on the relevant button. 

Choose a function name. m Cancel B 
[ RBS ] [ EHP ] [ LN ] [ NR ] [ SIN] 

[ RTRN ] [ FLl ) [LOCRTE) [ NOW ] [ SQRT ) 

[RLtERRGE] [ HOUR ] [ LOG ] [ NPLl ] [ STRRTS ] 

[ CHRR ] [ IF] (LOOKUP] [ PI] ( STDELl ] 

( COS ] ~NCLUDE~ ( MRH ] [ PMT ] ( SUM] 

[ COUNT] [INFINITY] ( MID ] fRELlIOU~ [ TRN ] 

[ DRTE ] [ I NT ] [ MIN ] [ P Ll ) [ TIM E ] 

[ DRY ) [I SERROR) [M I NUTE) [REPERT] [ TODRY ] 

[ ERROR] [ ISNR ] ( MOD ) [ ROUND] ( YERR ] 

[ EH I STS ] [LENGTH] (MONTH] (SECOND] 

• After making a choice, the dialog disappears and the fu~ction is 
automatically pasted for you into the fonnula panel of a data entry 
fonn or a report. The precise fonnat of a function depends on its 
type, but Reflex provides you with visual help in completing a 
fonnula that requires parameters by including a description of the 
valid or necessary parameters in an English-like fonnat. For 
example: 

LENGTH("Text_String") 

This function computes the LENGTH of the Text String in the 
parentheses. For more specific infonnation on functions see the 
section on Functions. 

• If you do not wish to select a function, simply click on the Cancel 
button. 

The Paste Function Name option is available whenever the fonnula 
panel in a report or database window is selected. 



Undo 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear 
Duplicate 3€D 

Paste Function Name 
Paste Ouery 

Edit Menu 

The Paste Query option is the equivalent of the Search On option 
available with data entry fonns in that it brings up the QueryBuild 
dialog. Query Build provides an automated method of creating 
accurate database or report queries. Whenever QueryBuild is 
invoked via this menu option, a standard file dialog will appear first, 
asking you to indicate the database file·with which you wish to 
work. Paste Query is available in all the same situations as Paste 
Function Name. 
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FORMAT MENU 
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nlign Left Sides 
nlign night Sides 
nlign L \n Centers 
nlign Tops 
nlign Bottoms 
nlign T\B Centers 

Hide Grid 
..... nlign To Grid 

Hide P e Widths 

The Format menu contains all the options you will need to format 
objects while designing data entry forms and reports. Special 
dialogs for Number, Date and Text field/label formats are accessed 
via the Display Format option. 



Display Format ... 

nH~]n t (~n }~[h~s 
nH~]n H~~]h t S~d(~~ 
m~~.~n t \H [~~n h~fS 
nH~.~n lops 
nH~]n Ho t toms 
nW.~n "(-.H C(H~t (~r~ 

•........ , .............................................. . 

Hide Grid 
....... Rlign To Grid" 

Hide Pa e Widths 

HH~]n t(~n }~~h~s 

~Hh.~n Hh.~h t Shh~~ 
HHqn t \H [~~n h~fS 
HH~]n lo~)s 

HH~.~n BoHoms 
HH~.~n l\H CHn1 (~r~ 

Hide Grid 
....... Rlign To Grid 

Hide Pa Widths 

Format Menu 

There are three very similar options that help you arrange the way in 
which field and label contents are displayed: Contents Left, 
Contents Right, and Contents Center. They all work in the 
same fashion: select one field or label and choose the relevant 
option. Fields may be selected within database file images in the 
Database Overview window to set content positions. 

• Contents Left: This left justifies the contents of a field. 

• Contents Right: This right justifies the contents of a field. 

• Contents Center: This centers the contents of a field. 

The Display Format option allows you to customize the way in 
which the contents of number, integer, sequence, date field or text 
field types will be displayed in data entry forms and reports. Using 
this feature on a field name in a file image presets that field's format 
for data entry and layout. Select a field and then choose the option. 
A dialog will appear showing the range of formats available; an 
example of each format will appear as you click on the relevant radio 
button. 
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Number, Integer, Sequence field dialog: 

@ General OK 
o Decimal 

o Scientific Cancel 

o Dollars 

o Percent 

Ill_I Digits to the right of the decimal point (0 to 15) 

o Format with commas 

[Hample 12345.61 

Date format dialog: 

@ Short Date Format OK 
o Long Date Format 

o Rbbreuiated Date Format Cancel 

[Hample 12/31/84 
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Format Menu 

Report Text field dialog: 

@ FiHed Height n OK J 
o Uariable Height 

Cancel 

The Text field display format dialog is only available when the 
selected text is in a Report. 

• A Fixed Height text field is of constant size, regardless. 

• During Report Design activity a Variable Height text field will 
always appear as big as you initially made it. 

• During Report Display, a Variable Height text field will shrink to 
the minimum height allowed by the text it contains (this may be zero 
to n lines). 
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[ 0 n h~ n t s U~ t t 
[onh~n ts fH9h1 
[onh~nts C(~n1 (~r 

Align Left Sides 
Align Right Sides 
Align L\,R Centers 
Align Tops 
Align Bottoms 
Align r'"B Centers 

Hide Grid 
./Rlign To Grid 

Hide Pa e Widths 
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Since Reflex's data entry fonns and reports can be highly 
customized, you will need to have some facility that does not rely 
solely on hand-eye coordination to position items accurately. The 
alignment options provide a range of ways in which fields, repeating 
collections, labels or pictures may be positioned relative to one 
another with great speed. 

Multliple objects are selected in data entry forms and reports by Shift 
Clicking. This technique involves: first selecting an object by 
clicking on it; then pressing the Shift key while clicking on as many 
other objects you wish. Each object selected in this manner will tum 
black to confinn that it has been selected. You can then use the 
standard Edit menu options (cut, paste, etc .. ), move the objects 
around manually, or select one of the options described below. 

• Align Left Sides: Aligns the left sides of all currently selected 
fields, repeating collections, labels and pictures with the left-most 
selected item. You select the items to align by Shift-Clicking on 
them. Useful when long reports must have labels and fields aligned 
vertically over many pages, or fields need to be grouped together in 
neat "stacks". 

Sel ected but unali gned Left Sides aligned 

• Align Right Sides: Aligns the right sides of all currently 
selected fields, repeating collections, labels and pictures with the 
right-most selected item. 

Selected but unaligned Right Sides aligned 



Format Menu 

• Align L \R Centers: Aligns fields, repeating collections, 
labels and pictures along their Left\Right centers. 

Selected but unaligned 

Left \Rl ght Centers a1 i gned 

• Align Tops: Aligns the tops of a group of fields, repeating 
collections, labels and pictures based on the location of the top-most 
selected item. 

Selected but unaligned 

Tops aligned 
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• Align Bottoms: Aligns the bottoms of a group of fields, 
repeating collections, labels and pictures based on the location of the 
bottom-most selected item. 

Selected but unaligned 

Bottoms aligned 

• Align T\B Centers: Aligns fields, repeating collections, 
labels and pictures based on the location of their Top\Bottom 
centers. 

Selected but unaligned 

Top\Bottom Centers aligned 



[ on h~n ts L.~ tt 
[ on h~n ts m9h1 
[on h~n ts C(~n1 Hf 

Align Left Sides 
Align Right Sides 
Align L \R Centers 
Align Tops 
Align Bottoms 
Align T\B Centers 

[onh~nts U~H 

[ on h~n ts m~jh1 
[on h~n ts C(~n1 (~r 

t····· .......... · ............ · .. · .... ·· .. · .... · ...... · .. 

Align Left Sides 
Align Right Sides 
Align L \R Centers 
Align Tops 
Align Bottoms 
Align T\B Centers 

Format Menu 

Whenever you start to design a new report or layout a data entry 
form, Reflex automatically provides a visual grid feature to make the 
accurate positioning of fields, repeating collections, etc, that much 
easier. You can always remove this default grid by selecting Hide 
Grid - this option will then read Show Grid, enabling you to bring 
the grid back at any time. No grid is shown during data entry or 
report display. 

The Align To Grid option ensures that fields, repeating collections, 
labels, etc, will "snap" to the closest grid point. The design grid in 
data entry forms and reports provides a resolution of eight points per 
rectangle both in the horizontal and vertical directions. This feature 
makes the positioning of items during design work really easy. 
Align to Grid is the default - it can be turned off by selecting the 
Align To Grid option once again. 
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[ O~) h~n ts U~ tt 
[onh~nts m~Jh1 
[ o~, h~n ts C(~n1 m· 

Rlign Left Sides 
Rlign Right Sides 
Rlign L \R Centers 
Rlign Tops 
Rlign Bottoms 
Rlign T\B Centers 

Show Grid 
v"'Rlign To Grid 

Hide Page Widths 

252 

Reflex automatically displays the current page width on any data 
entry form or report you are designing. The page boundaries are 
signified by a solid black vertical line and the actual location of this 
line will depend on the page layout you arrange via the Page Setup 
menu option located in the File Menu. It will often be important to 
know just where the page width boundary is so that you don't 
inadvertently place objects off the page. The Hide Page Widths 
option is used to tum the display of such page boundaries on and 
off. 

• 
• File Edit Format Describe Report Fonts Style WiD( 

Birthday List 

1thDate 

BirthDate: . .. . 
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DESCRIBE MENU 

Describe Menu 

While developing database files in the Overview window, 
you will always have to tell Reflex the type of fields with 
which it will be dealing. In other words, you must decide 
what type of contents a particular field is meant to hold. The 
seven possible field types are: Text, Number, Integer, 
Date, Logical, Time, and Sequence. 

Once a set of fields have been created, you must then decide 
which field(s) will fonn the Key. Set Key fields via the Key 
Field option. Change Key fields back into ordinary fields by 
using the Non-Key field option. 

When you wish to have a record in one database file 
associated with other records in the same or another file, you 
will need to use a pair of Links. The two options - A Link to 
One " ... " Record and A Collection of Links to " ... " 
Records - are provided for this purpose. 

Describe menu options are updated (changed) when you 
switch from the Overview window to a database window and 
when you make a report window the active window. 

• Database window options: When you switch from 
the Overview window to a data entry or fonn layout window, 
the Describe menu alters only slightly. There are two options 
for new objects - Labels and Pictures. Since you cannot set 
Links between records or make fields Key Fields or Non-Key 
fields while a file is open, these options have changed in their 
nature. The options for Links and Key fields are now included 
purely for descriptive purposes. 

• Report window options: When you switch to a report 
window all seven field type options remain, but those for 
Links and Key fields are not shown. Instead, the lower part of 
the menu includes features for setting up Labels, Pictures, 
Repeating Collections, report page Headers/Footers, and the 
position of page breaks. 

All options are now described in more detail. 
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Number field 
Integer field 
Date field 
Logical Field 
Time field 
Sequence field 

HUnk 10 Hrw ""," H(~( nn! 
H I: n!h'cHon 01" Links 10 ""," fhH onis 

..... Key field 
Non-Ke field 
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The Overview Describe Menu 

I • File Edit Format .lu~'U.IIl=- Oueruiew Window 
TeHt Field 
Number Field 
Integer Field 
Dote Field 
logical Field 
Time Field 
Sequence field 

R link to One " ... " Record 
R Collection of Links to " ... " Records 

Key Field 
Non-Key field 

J 

This is the initial Describe menu that you will see after loading 
Reflex. It contains everything you will need to design, create 
and modify database file images within the Overview 
Window. 

The Text Field option is used to indicate that a specific 
database or report field can contain any text string. A text 
string consists of one or more characters from the Macintosh 
character set including letters, numbers, symbols and special 
foreign language letters. Note that even though some entries 
might look more like numbers (telephone number, social 
security numbers, part numbers, etc), they do not have a valid 
number format and must therefore be classed as text fields. 

The following are valid text field entries . 

A name: 
An address: 
A telephone number: 

Frank Smith 
1256 Savanna Avenue 

(499) 999-9999 



.. 
TeHt Field 

.- • I 

Integer Field 
Date Field 
Logical Field 
Time Field 
Sequence Field 

Key Field 
..... Non-Key Field 

... 
./TeHt Field 

Number Field 

Date Field 
logical Field 
Time Field 
Sequence Field 

8CK 

Key Field 3€K 
..... Non-Key Field 

Describe Menu 

There are three kin4s of fields that will accept entries strictly in 
the fonn of numerical digits: the Number Field, the Integer 
field, and the Sequence field. The Number field is used when 
you will need to do calculations that require the precision 
offered by floating point arithmetic and the capability to handle 
very large/small numbers and fractions. Reflex provides up to 
15 decimal digits of precision in calculations. Typically, 
number fields are used when you are dealing with: the price of 
an item; an interest rate; the result of some mathematical 
operation; large distances (eg: the distance to local stars), 
etc ... 

Because of the greater precision afforded by the Number field 
option, calculations involving these fields take longer than 
fields of type Integer. Integer values may be entered in 
Number fields. 

The Integer Field type operates much like the number field 
in that it accepts numerical infonnation - the difference is that 
it only deals with whole numbers in the range: 
-2,147,483,647 to +2,147,483,647). Integers exist as a 
field type because they can be stored more compactly and can 
be computed more quickly. 
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.. ' .' 
TeHt Field 
Number Field 
I nteger Field 

-'.' '. 
LogicDI Field ~ 
Time Field 
Sequence Field 

Key Field 
.... Non-Key Field 

.. ' .' 
TeHt Field 
Number Field 
Integer Field 
DDte Field 
II • • I 

Time Field 
Sequence Field 

Key Field 
.... Non-I(ey Field 
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WK 

WK 

Date Fields will only accept entries in a valid date format, 
which takes the form of: 

Month/Day!Y ear 

While this is the only input format, Reflex allows you to 
choose from three date display formats in reports: 

Short Date Format: 2/2/86 
Long Date Format: February 6, 1986 
Abbreviated Date Format: Feb 6, 1986 

Choose which form you want by using the Display Format 
option located in the Format Menu, 

The Logical Field type is used whenever you wish to 
indicate that a condition is true or false, by entering the values 
"TRUE" and "FALSE", 



·. 
TeHt field 
Number field 
I nteger field 
Dilte field 
Logicill field ... 
Sequence field It 

Describe Menu 

The Time Field option is used to ensure that a specific field 
only accepts information in a valid time format. Reflex uses 
the 24-hour time format, as below: 

9 am must be entered as 9:00 or 09:00:00 
12.1Opm must be entered as 12: 10:00 or 12: 10 
12.10am must be entered as 00:10:00 

H I: l)!h~e1 ion of !.inks 10 ., '" ,. fI(H onis 8.34pm must be entered as 20:34:00 or 20:34 

Key field 
..... Non-Key field 

-, .. 
........ eHt field 

Number field 
I nteger Field 
Dilte field 
Logicill field 
Time field ...... 

3€K Time values may be used in data entry and report form 
formulas provided they, like Date values, are preceded by the 
@ symbol. 

Reflex does not automatically tag each record with a unique 
number as it is entered. If you require record numbers, the 
Sequence Field type may be used. The actual record 

.................................................................................. 't ....................................... . 

number given to a record will depend on the number of 
records already in a database, but the numbering technique is 
based on taking the highest number already allotted and 
adding one to it. There can be only one Sequence Field per 
database - the Sequence Field option will be dimmed (gray) if 
the current database file already contains a field of this type. 

Key field 
..... Non-Key field 

• If there are 0 records in a database, the first record entered 
will automatically be given the Sequence number of 1. 

• If records are deleted, "gaps" will appear in the record 
number sequence. You may, if you wish, manually give an 
existing or new record the Sequence number of a deleted 
record. You can also change any existing sequence field 
number to fill in a gap between records or to create a gap 
between records. 

• You can, if you wish, start record numbers at some specific 
value (such as starting with a record for a check number of 
100). 
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Reflex allows you to associate the records in connected 
database files. The two Describe menu options concerned 
with record linking are: A Link to One" 000" Record and 
A Collection of Links to Many "000" Records. 

• A Link to One " ... " Record: This option is used to arrange 
it so that the current record in the current file is associated 
with at most one other record in another file to which it is 
connected by a link line. (Note that there are situations where 
you will want to associate records within a single database file . 
Reflex allows you to do this). The A Link to One " ... " 
Record option is available when a Link in a file image is 
selected. 

• A Collection of Links to Many" ... " Records: This option 
is used to arrange it so that the current record in the current 
file is associated with zero, one or more records in another 
file to which it is connected by a link line. The A Collection of 
Links to Many" ... " Records option is available when a Link 
in a file image is selected. 

While both of these options are used initially to setup the state 
of a Link at either end of a link line, they can also be used 
later to change the status of a Link. 



I· •• 

..IreHt Field 
Number Field 
I nteger Field 
Date Field 
Logical Field 
Time Field 
S(H!tl(mO~ H(~ld 

Key Field #K 
Non-Key Field 

Describe Menu 

All Reflex database files must have Oat least one field set as a 
Key Field to ensure that every record in that file can be 
uniquely identified. The Key may consist of a single Key 
field (such as an employee number or a part number) or a 
combination of Key fields (such as a supplier name, the name 
of a part shipped by that supplier, and a project name which 
uses the part shipped by the supplier). 

• A non-key field may be made a key field by selecting it and 
then choosing the Key-Field option. 

• A key-field may be changed back into a non-key field by 
selecting it and choosing the Non-Key Field option. 

All Key fields are immediately recognizable by the underline 
that appears below them. Database records will be 
automatically sorted in order of the Key fields. That is, if the 
Key fields are LastName and FirstName, all records will first 
be sorted LastN arne and then on FirstN arne. 

Layout Describe Menu 

Number Field 
Integer Field 
Date Field 
Logical Field 
Time Field 
Sequence Field 

Label 
Picture 
R Link to One " •.• " Record 
R Collection of links to " ••. " Records 
Cop of Ke Field 

The Layout Describe menu appears when you select the Form 
Layout option from the Database menu during data entry. 

259 



Lobel 
Picture 
R Link to One " ... " Record 
R Collection of Links to " ••• " Records 
Co of Ke field 

... .. 
NmntHw fi.~111 
Inb~I.JN n(~ld 

I)I~t.~ Held 
l.o~Ji( 01 n(~ld 
linH~ H(~ld 

S(Hlu(~rH.~ r i(~ld 

... 
Pil:1un~ 't 

H !.ink 1 0 {!n(~ -, '" ,- H(H on1 
n I: !)lh~I:1 ion of Links 10 -, '" ,- f!<~( onis 
l:ol)!.~ of K(~~j n.~ld 

260 

The first seven field type options remain the same as in the 
Overview window Describe menu, only the lower portion has 
been updated. The four lower options are not commands, 
they simply aid the user in indentifying the currently selected 
object. 

A Label may contain a title, a heading, an annotation, an 
instruction, or any other descriptive text you want to include 
in your data entry forms or reports. A Label may be placed 
anywhere in a data entry form or report so long as it does not 
overlap any other label or field. If it does overlap, Reflex will 
display a dialog to that effect. Also, Labels can be as wide or 
as deep as you wish and carriage returns may be used to 
section Label text into paragraphs . 

• In a data entry form, Reflex automatically places labels 
next to each field name. These can be changed at any time by 
switching into Form Layout and editing the label as you 
would any other Macintosh text. You may also create entirely 
new labels by clicking down on the form and starting to type. 
Alternatively, first draw a black box with the mouse and then 
select Label from the Describe menu. Click in the field and 
then enter text. 

The Label option is available whenever you are customizing a 
data entry form or report. 
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Describe Menu 

Graphic images or Pictures may be created in MacPaint, 
MacDraw or any other Macintosh graphics program, and then 
"cut and pasted" into a Reflex data entry form or report. This 
feature can be useful for inserting special page layout designs 
into data entry forms and logos into reports. Fields may be 
placed anywhere (embedded) within graphic images for 
greater visual effect. 

This menu option is not a command and is descriptive only; a 
check mark appears next to the option when the current 
selection is of the Picture type. Pictures may not be edited 
within Reflex, they can only be transported from place to 
place via the clipboard's cut and paste facilities. 

This option will be checked when the currently selected object 
is, for example, a record Link which is associated with at 
most one record in a database file called Person. 

This option will be checked when the currently selected object 
is, for example, a Collection of Links to records in a database 
file called stockbuy. 
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This option will be checked, and a name will appear within 
quotation marks, when the currently selected object is a copy 
of a Key field from a linked record. Key field copies only 
exist within a Link or a Collection of Links in a data entry 
form. 

The Report Describe Menu 

l -' File Edit Format •• · I' Report Fonts Style Window I 
TeHt Field 
Numb'er Field 
Integer Field 
Date Field 
Logical Field 
Time Field 
Sequence Field 

Label 
Picture 
Repeating Collection 
Header of " ... " 

No Page Breaks 
Page Break Before 
Page Break Hfter 

The Report Describe menu appears whenever you create a 
new report, or use/modify an existing report. It contains 
report specific options that allow you to create Headers and 
Footers and to specify where you would/would not like 
Page Breaks to occur. 
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Describe Menu 

The first nine options in the Report Describe menu are used to 
create labels, set fields to different types and identify pictures 
that have been pasted into a report. The five remaining options 
are discussed below. 

The Repeating Collection option is used to create a 
repeating collection in a report. Simply draw a generic black 
box anywhere in a report and then select this option - the box 
will become a repeating collection. 
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Break Before 
Break Rfter 

This option is checked when the selected object is a Header in 
the current report. If a Footer is selected this option becomes 
Footer of " ... ". 

This option is used to indicate that you do not wish the 
contents of some specific report object to be split across pages 
during printing. Draw a thin vertical black bar next to the 
report object and select this option - the vertical bar will 
become a No Page Breaks icon. 
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Label 
Picture 
Repeating Collection 
Header of " ••• " 

Describe Menu 

This option is used to indicate that you wish page breaks to 
only occur before the selected object during printing. Click 
the mouse button with the cursor next to the relevant report 
object to get a generic black box. Select the Page Break 
Before option - the black box will become a Page Break 
Before icon. 

This option is used to indicate that you wish page breaks to 
only occur after the selected object during printing. Click the 
mouse button with the cursor next to the relevant report object 
to get a generic black box. Select the Page Break After 
option - the black box will become a "Page Break After" icon. 
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MENU 
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Show Database File ... 
Hide Database File " .•• " 
Show Linked Files 886 
Protect Design 

Insert Field 

The Overview menu is only available when the Overview window is 
active. All the menu options here are concerned with operations on 
file images in the Overview window. 

The Show Database File option is used to display a file image in 
the Overview window. It does not open a database file - it merely 
displays the structure of the file so that you can view or modify it. 

U sing Show Database File presents a dialog box that contains a list 
of all Reflex database files that exist on the current disk. Select the 
file name you wish to view and click on Open. Alternatively, click 
twice on the file image name bar, but not on the status icon. 
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Show Linked Files It 8€G 
Protect Design 

Insert Field 

Show Database File ••• 

I nsert Field 

Overview Menu 

There are two ways to to remove a file image from the Overview 
window: 

• Simply select the file and choose the Hide Database File 
option. The selected file name will appear in the menu to visually 
confirm which file is about to be hidden. If the selected file is open 
or hasn't yet been saved or if no file is selected, this command is not 
active (gray). 

• Alternatively, use the much faster method of clicking on the file's 
status icon. This has the same effect as clicking on the close box of a 
Macintosh window. 

Hiding a file does not affect a database file in any way - it just 
removes its image. 

After showing an individual database in the Overview window, it is 
often useful to show any other files which contain linked records. 
Show Linked Files does just this. 

• Reflex shows only the files with records that are directly linked to 
those in the selected file; the last file to be shown becomes the 
selected file. 

• To see any other files containing records linked to those in the 
new current file, choose Show Linked Files once again, or use the 
000 shortcut. 
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The Protect Design option allows you to stop any changes being 
made to an existing file design. To use, you simply select the 
relevant file image and then choose the Protect Design option (a 
check mark will appear next to it in the menu). To remove the 
protection, select the file image and then choose the Protect Design 
option once again. 

The Insert Field option inserts a new field space below the 
currently selected existing field or, if the entire file is selected, below 
the last field in the file image. It can be used with new (unsaved) file 
images, or with existing file images; in the latter case you will have 
to save the design once again. Newly inserted fields can be placed 
at any position within the file image. Also, if you later reposition a 
non-key fieldabove a Key field, it will become a Key field; if a Key 
field is placed below a Non-key field, it will become a non-key 
field. New field(s) will appear below previously existing fields in 
data entry forms, regardless of their position in the Overview file 
image. You can reorder data entry fields and their associated labels 
at any time by selecting the Form Layout option from the Database 
menu. If you do this, the order of fields in the file image will be 
updated to match the modified data entry form. 
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Form Layout 

The Database menu contains all the data entry options you will 
need while using a data entry fonn plus the Fonn Layout option. 
This menu only appears when a data entry window is the active 
window. 

The New Record option is used to insert a new blank record into 
the active data entry fonn. Once filled in and added to the database 
file, the new record will automatically be placed in the correct sort 
position depending on the current record Key. 
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Form Layout 

The Delete Record option is used to delete the currently displayed 
record from the current database file. If Link checking is enabled, 
you can delete any record providing it doesn't have A Collection of 
Links to records where the backlink is part of the Key. This is the 
same restriction as on deleting a Link; you must delete all such Links 
(not records) from the "other end". When you delete a record, it 
deletes all its Links for you. 

The Copy Record option is used to make a copy of the current 
record in the active data entry form. This saves a lot of retyping 
when a number of very similar records need to be entered. Since 
each copy is an exact duplicate of an already existing record, you 
cannot insert a record copy into the current file until the Key is 
modified so that it is once again unique. Alternatively, you can use 
the "Revert" option to change the record copy to a blank new record 
if you decide you don't need it. 

The Enter Record option does just that - it enters the current 
New Record 
Delete Record 
Copy Record 

HE record into the current database file. 
Hl 
HM 
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N.~UJ Unk :.:H 
n(~1<~1H Unl< 
ShOll; t ~nk (HI fI(H ord :.:G 

Form Layout 
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Database Menu 

The New Link option is used to create a new blank Link in a 
Collection of Links in the current record. This item is only active if a 
Copy of a Key Field in a Collection of Links is selected. 

The Delete Link option is used to remove a selected Link from the 
New Record 
Delete Record 
Copy Record 
Enter Record 

a€E current record. This item is active only if a Copy of a Key Field in a 
a€T Link is selected. 
a€M 
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New Link a€H 
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Form Layout 

The Show Linked Record option is used to display the record in 
another file linked to the current record in the current file. If the file 
which contains a linked record is not open, it will be opened. When 
the file is open, Reflex will display the associated record in the 
relevant database window, behind the currently active window. This 
item is active only if a Copy of a Key Field in a Link is selected. 
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The Form Layout option is used when you wish to switch from 
displaying infonnation in a data entry fonn to designing the layout 
of that fonn. Grid lines will appear in the layout fonn window and 
the activity indicator at bottom left of the window will contain the 
words "Fonn Layout". 
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The Search menu contains options that help you browse through all 
or just some records in a database file. It is also the menu you will 
use to display the QueryBuild dialog. It is only available when the 
current window is a database window. 

The First Record option displays the first qualified database file 
record in the current data entry form. If there is no record 
qualification in the formula panel, using First Record will show the 
very first record entered into the file. If there is a record qualification 
in the formula panel, the first qualified record will be displayed. 

The Last Record option displays the last qualified database file 
record in the current data entry form. If there is no record 
qualification in the formula panel, using Last Record will show the 
very last record entered into the file. If there is a record qualification 
in the formula panel, the last qualified record will be displayed. 
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The Next Record option is used to move one record at a time 
through the records in a database file. If there is no record 
qualification in the formula panel, then Next Record will move one 
record closer to the end of the file from the current record. If there is 
a record qualification in the query panel, this option will move one 
qualified record closer to the end of the file from the current 
qualified record. 

The Prior Record option is used to move one record at a time 
through the records in a database file. If there is no record 
qualification in the formula panel, then Prior Record will move one 
record closer to the beginning of the file from the current record. If 
there is a record qualification in the query panel, this option will 
move one qualified record closer to the beginning of the file from the 
current qualified record. 

The Search On option is used to invoke the Query Build dialog 
- the Reflex feature which assists you in building record 
qualifications that specify which records will be displayed. 

The Find All option is used when you want to display all records 
in a database file. This is used when a record qualification is present 
in the formula panel and you now wish to remove it. 
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Search Menu 

The Edit Record Qualification option is used to place the 
insertion point cursor in the fonnula panel. If there is no record 
qualification in the fonnula panel, the insertion point is placed at the 
left-most point of the fonnula panel. If a record qualification already 
exists in the fonnula panel, the Edit Record Qualification option 
selects,the whole record qualification, ready for editing. 
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Delete Qualified Records 
EHport Qualified Records ••• 
Import Records ••• 

"ICheck Links 

The Misc menu contains features that you will need to delete 
multiple records, interchange information with other applications, 
and tum Reflex's record linking mechanism on and off. It is only 
available when the active window is a database window. 

The Delete Qualified Records option acts in two ways. If there 
is no record qualification in the formula panel (and all records are 
therefore qualified), all records will be deleted. If there is a record 
qualification in the formula panel (and only a subset of the database 
file is therefore currently qualified) only those records that are 
qualified will be deleted. In both cases, Reflex will display a dialog 
warning you of what is about to happen and you have the option of. 
proceeding with the record deletions or clicking on the Cancel 
button. 
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Mise Menu 

Reflex provides the Import and Export record options to enable 
you to interchange information in a textual format with other 
applications, or even between Reflex documents. For example, 
information produced in an Reflex report can be exported and then 
imported into a database file, thus creating a completely new file. 

Reflex expects text files that are to be imported to have a format that 
matches the field and Link list specified for the database file that will 
receive the text file information. You specify the field and Link list 
via a dialog box that appears whenever you select Export Qualified 
Records or Import Records. Fields may be chosen for export or 
import in any order you wish. 

There are three import/export formats that are supported: Clipboard, 
Text file, and Mail Merge.For more specific information on Import 
and Export, see the discussion in the section entitled Details & 
Techniques. 

The Check Links option is used to tum Reflex's record link 
checking mechanism on and off. When there is a check mark 
alongside this option, Reflex will not allow the Links in associated 
records to contain inconsistent information. Check Links should 
only be turned off if you need to repair a damaged database . 
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The Layout menu is displayed when you select Form Layout from 
the Database menu. It contains options that allow you to set up field 
entry qualifications, protect single objects in a form or the whole 
form, and group together the copies of Key field.s that are contained 
in a Link. 

The Edit Field Qualification option is used to select the formula 
panel in a Form Layout window so that you can insert a field 
qualification if there is none, or edit any field qualification that 
already exists. A field qualification is simply a qualification which 
is used to monitor any entry in a specific field. 

• If the field qualification is True for a field entry then the entry is 
allowed to be a value of the field. Provided all other fields in that 
record are also acceptable (they have no field qualifications or they 
do not have field qualifications with values of False), the record may 
be written to the current database. 

• If the field qualification is False for a field entry, then the entry is 
not allowed to be a value of the field. No record that contains a field 
qualification with a value of false may be written to the current 
database. The field containing the invalid entry will be selected and 
an appropriate message will appear. 
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Layout Menu 

The Protect Object and Protect Form options operate in a very 
similar manner, they only differ in scope: 

• Individual objects (a field, group of fields, labels, or pictures, 
etc ... ) protected with the Protect Object option may not be modified 
in any way. 

• A whole data entry form protected with the Protect Form may not 
be modified in any way. 

Both levels of protection can be removed by selecting the relevant 
menu option a second time. 

The Group Link Key Fields option is used to disallow selection 
of individual Key field copies inside a Link. Key field copies can be 
ungrouped by selecting this menu option when it is checked; you 
would ungroup Key field copies inside a Link to rearrange or to 
resize them. 

The Data Entry option switches a Form Layout window into a data 
entry windo,W. Selecting this option replaces the Layout menu with 
the Database menu. 
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" File Edit Format Describe '. I I Fonts Style Window 
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The Report menu contains all the options you will need to design 
and calculate ~eflex reports. Data may even be exported from 
reports via this menu. It is the only menu with report specific 
options. 

Unlik~ spreadsheet programs which typically recalculate the 
complete matrix each time a value is entered, Reflex reports are 
calculated manually each time you want to display them. If a report 
includes one or more repeating collections, Reflex automatically 
switches from Report Design to Report Display on calculation. 
Select the Calculate option from this menu, or use the 00= 
shortcut. 
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Report Menu 

When you specify which fields are to be part of the Key in a 
database, Reflex uses the key field( s) to sort the records into 
ascending order. The Sort On Fields ••. option is used to 
produce a report sorted on fields other than the Key field(s). You 
should always select the repeating collection that is to contain the 
newly sorted infonnation. If you do not, Reflex will select the first 
repeating collection in the report for you. If there are no repeating 
collections in the report, Reflex will display the dialog shown 
below: 

You must select the Repeating Collection 
that you wish to sort before inuoking this 
command . 

I( OK )1 

After selecting the relevant repeating collection and selecting Sort On 
Fields ... , another dialog will appear asking you to select the fields to 
sort on. Select each field in tum by clicking on them. For each field 
to be sorted, click on either the A ... Z,O ... 9 or the Z ... A,9 ... 0 button 
to tell Reflex whether you want the records to be sorted in an 
ascending or descending order. 

Finally, click on the OK button. The dialog will go away and the 
report window you are working with will become active once again. 
Use the Calculate option or 00= shortcut to see the records in their 
new sort order. 
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The Edit Formula option is used to place the text cursor in the 
Fonnula panel. If there is no text in the fonnula panel, the cursor is 
placed at. the far left of the panel. If there is some text in the panel, 
the whole panel is selected. You may also click directly in the panel 
and change any text there by using standard Macintosh text editing 
techniques. 

The Edit Name option is used to select the contents of the Name 
Panel in a report window so that you may change the name of any 
currently selected object. You may also click directly in the panel 
and change any text there by using standard Macintosh text editing 
techniques. 



Protecting 
Reports & Report 
Objects 

Calculate 3€= 

Sort On Fields ... 
Edit Formula 3€Q 
Edit Name 3€ I 
Prote( t Ob jett 
Prote( t Report 
EHport Data ..• 

Show Header 
Show Footer 

Display 
....... Oesign 

Calculate 88= 

Sort On Fields ... 
Edit Formula· 88Q 
Edit Name 88 I 
Protect Object 
Protect Report 

Show Header 
Show Footer 

Display 
....... Oesi n 

Report Menu 

As with data entry fonns, any object in a report or a complete report 
itself, can be protected from accidental design changes. To protect 
an object simply it and use the Protect Object option. Use 
Protect Report to protect the current report. If a field is protected 
or a report containing that field is protected, only the value in the 
field may be edited. 

Infonnation produced in a repeating collection of a report can be 
exported via the Export Data ... option. Repeating Collection 
infonnation may be exported to other applications via the Macintosh 
clipboard or to a text file in standard fonnat or mail merge fonnat. 

However, a really powerful feature of Reflex is that you can convert 
the infonnation in a report into a datbase file. To do this, simply 
export repeating collection infonnation and then import it into a new 
or existing database file. See the discussion on Exporting and 
Importing data in the Details and Techniques section. 
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Header and 
Footer Options 

Calculate $= 

Sort On Fields ... 
[d~ t ~: O~lnu~<~ ~)('a 

[t1~ t N<Hne ~)(, ~ 

Pro1(~( t Obj~~~;1 
Protect Report 
[Hport Data ... 

Shol1' Header 
ShOll' Footer 

....... Display 
Design 

Calculate $= 

Sort On Fields •.. 
[d~ t r ormu~<~ ~)t'O 

[dH N<HfW ~)(, ~ 

ProhH t Obj~~~~1 
Protect Report 
[Hport Data .•. 

Show Header 
Show Footer 
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The Show Header and Show Footer options are used to display 
a header or footer for a report. You may have both a header and a 
footer in a report, but they both cannot be visible and edited at the 
same time. Options are: 

• A global header and/or footer for a report. 

• A header or footer of a repeating collection: Since it is not 
possible to predict how many records will be produced by a given 
repeating collection, you are able to attach a header and/or footer to ;: 
repeating collection so that if it produces more records than can fit 
on a page, your selected header, or footer, will print on the bottom 
of each page and the top of the next page that the repeating collectiOl 
spans . 

If a header/footer is visible, the Show Header/Show Footer option 
changes to Hide Header/Footer and can then be used to hide the 
header/footer. 

The Display option is used to swit~h from report design to report 
display; the design grid lines disappear and the report contents are 
displayed. If there have been no changes to the report design, 
Reflex does not recalculate an already calculated report. If changes 
have been made, Reflex will automatically recalculate the report for 
you. 



Calculate 8€= 

Sort On Fields .•. 
[d~ t l: oHnu~<} ~j[,O 

[d~ t N<m}(~ ~j[, ~ 

Pro1 ~H t Obj~~e1 
Protect Report 
EHport Data ..• 

Show Header 
Show Footer 

..... Display 
Design 

Report Menu 

The Design option is used when you wish to switch from 
displaying report contents to making changes to the report design. 
If you attempt to make any design changes while displaying report 
infonnation, Reflex will at first beep, and then display the dialog 
shown below: 

The last change can only be done while in 
Design mode. Do you want to switch to 
Design mode? 

(( Design 11 

( [ancel ) 

Click on the Design button to switch to report design work. 
Alternatively, click on the Cancel button to send the dialog away. 
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FONTS MENU 

Times 
Symbol 
Los Rngeles 
Heluetica 
Cairo 
Toronto 
San Francisco 
Uenice 
London 
Hthens 
Taliesin 
Chicago 
Geneua 
New York 
Monaco 
Courier 
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Since Reflex data entry fonns and reports can feature labels and 
fields of different fonts, the standard Macintosh Fonts menu is 
included. Select the object you want to set to a particular font and 
then select the relevant option from the Fonts menu. All Macintosh 
fonts are supported, but the available range will depend on which 
fonts you have installed or removed with Apple's Font/DA Mover™ 
utility. Only the first 16 fonts are shown in the menu. The Fonts 
menu is only available when Fonn Layout and Report Design 
windows are active. For more detailed infonnation on this menu see 
Macintosh™, the owner's guide. 



STYLE MENU 

.",.....Plain 
Bold 
1IIIIie 
Underline 
mm1JDnm~ 
0lilfDaJQl[!ll 

6 Point 
9 Point 
10 Point 
12 Point 
14 Point 
18 Point 
24 Point 

Fonts & Style Menus 

The Style menu is the companion menu to Fonts. It offers the 
standard Macintosh font style options. For more detailed 
information on this menu see Macintosh™, the owner's 
guide. 
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WINDOW MENU 
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When you have opened more than a few windows it can be difficult 
to find the one you want to work with since it may be hidden from 
view. In this case, go to the Window menu and select the name of 
the window that you wish to work with - it will become the active 
window. The name of the currently active window will always have 
a check mark alongside it. 

Address 
City 
State 
Zip 
netWorth 
the Stocks 

The Window menu is always available. 



REFLEX 
FUNCTIONS 

Function Types 

Formats, Arguments 
& Results 

Functions 

Reflex provides a rich list of functions which can be used use to 
retrieve information from database files or to create and customize 
reports. Those users who are familiar with spreadsheet programs 
will recognize many of the functions, but take note that some have 
been enhanced for use with database files. Others are unique to 
Reflex. 

Reflex functions fall into five main categories: 

Text Functions: These work with text strings. 

Arithmetic Functions: These provide a range of sophisticated 
number manipulation capabilities. Both Integers and Numbers can 
be handled. 

Date Functions: These work with date information. 

Time Functions: These work with time values. 

Special Functions: These functions provide powerful tools with 
which to further retrieve data - some will be new to you. Check to 
see if they are appropriate for work you are doing. 

Reflex functions may take zero, one, or more Arguments 
(depending on the function), but they always only produce one 
Result. Arguments can be text or numeric values, expressions, or 
the result of other functions. The type of Result returned is 
dependent on the function involved. 

Examples: 

NOW 

The NOW function does not require any argument. It returns a time 
result, which is in fact the current time value obtained from the 
Macintosh system clock. 

INT(5.1) 

The INT function takes a single Number as an argument and returns 
the integer (whole number) portion. In the example, INT is the 
function name and 5.1 is the argument. The result would be 5. 
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REPEA T(" *" ,3) 

The REPEAT function takes a Text and a Number argument and 
displays the text string the specified number of times. In this 
example, REPEAT is the function name, "*" is the text string 
argument, and 3 is the number argument. The result would be ***. 

A VERAGE(1,2,3) 

The AVERAGE function takes a List of Numbers as arguments and 
returns that average value of that list. In the example, AVERAGE is 
the function name. 1,2,3 is the argument list. The result would be 2. 

Refer to the Name/Argument!Result heading over each function 
name for specific guidance. 

TEXT FUNCTIONS 
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[ CHRR ] Argument Type: NUMBER Result: TEXT 

CHAR(Number) 

The CHAR function converts a given Number value to a Text 
String. 

Example 1: CHAR(13) ~ carriage return 

Example 2: CHAR( 66) ~ B 

[I NCLUOES] Argument Type: TEXT Result: LOGICAL 

INCL UDES(tI Text_String", "Target_Text _Pattern") 

Returns TRUE if the exact Target Text Pattern is found at any 
position in Text String. Otherwise it returns FALSE. 

Example: INCLUDES("Tuesday", "day") , TRUE 



Functions 

( LEN 6TH) Argument Type : TEXT Result: INTEGER 

LENGTH(" Text_String") 

Calculates the LENGTH of any Text value and returns an Integer 
value. 

Example: LENGTH("Four") ~ 4 

( LOCATE) Argument Types: TEXT,TEXT Result: INTEGER 

LOCA TE(" Text_String", "Target_Text _Pattern") 

LOCATEs the starting position of Target Text Pattern in Text String. 

• The first character of Text String is position 1, the second is 2, 
etc. 

• If LOCATE returns a zero value, the Target text pattern was not 
found in Text String. 

Example 1: LOCATE("The result should be five","r") ~ 5 

This example locates the letter "r" at the beginning of the word 
"result". 

Example 2: LOCATE("Tuesday", "Monday") ~ 0 

In this example, the locate function cannot find the text string 
"Monday" in the text string "Tuesday" and so a zero result is 
returned. 
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( MID) Argument Types: TEXT,NUMBER,NUMBER Result: TEXT 

( REPERT ) 

MID(ltText_String", Start_Position, Count_of_ Characters) 

Extracts a part of Text String, Count of Characters in length, 
beginning at Start Position. 

Example: MID("254 Middle Avenue, San Diego, CA",20,9) 
-+ San Diego 

In this example, the MID function extracts "San Diego" from the text 
string. 

Argument Types: TEXT, NUMBER 

REPEAT(" Text_String" , Repeat_Count) 

Repeats Text String for Repeat Count times. 

Result: TEXT 

Example 1: REPEAT("Say that again .. ",2) -+ Say that 
again .. Say that again .. 

This example shows how to repeat a text string a specific number of 
times. 

Example 2: REPEAT("*",4) -+ **** 

Special characters from Macintosh fonts may be displayed a specific 
number of times with the REPEAT function as well. This example 
displays the "*" character four times. 



Functions 

( STARTS) Argument Types: TEXT,TEXT Result: LOGICAL 

ARITHMETIC 
FUNCTIONS 
(with zero or 
one argument). 

Returns TRUE if Target String STARTS with Target Text Pattern. 
Otherwise returns FALSE. 

Example: STARTS("Tuesday","Tu") -+ TRUE 

( ABS ) Argument Type: NUMBER Result: NUMBER 

( EHP ) 

ABS(Number) 

Gives the ABSolute value of Number; it returns the magnititude of 
Number without a leading sign. 

Example: ABS( -45.4) -+ 45.4 

Argument Type: NUMBER Result: NUMBER 

EXP(Number) 

Gives the EXPonentiation of the transcendental number represented 
by the letter e raised to the power of Number. Also see the LN 
arithmetic function below. 

Example: EXP(2.5) -+ 12.1824939607035 
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[I NFl N 1 TY] Argument Type: NONE Result: NUMBER 

INFINITY 

Gives the largest possible number - it will always be larger than any 
number it is compared with, excluding INFINITY. 

[ 1 NT ] Argument Type: NUMBER Result: INTEGER 

INT(Number) 

Gives the INTeger portion of Number 

• If Number is an integer, the INT function returns the same 
Number. 

• If Number contains a whole number and a fraction, the INT 
function strips away the fraction and returns just the whole number. 
This works for positive and negative numbers. 

• If Number is less than + 1 but greater than zero, the INT function 
returns a zero (0). 

• If Number is between - .999 ... and zero the INT function returns 
a zero. 

Example 1: INT( 443.6) -+ 443 

Example 2: INT(.99) -+ 0 



Functions 

( LN ) Argument Type: NUMBER Result: NUMBER 

( LOG) 

( PI) 

LN(Number) 

Gives the natural logarithm of Number to the base e. This is the 
inverse function of EXP. 

Example 1: LN(4) -+ 1.38629436111989 

Example 2: LN(EXP(2» -+ 2 

Argument Type: NUMBER Result: NUMBER 

LOG (Number) 

Gives the LOGarithm of Number to base 10. 

Example: LOG(100) -+ 2 

Argument Type: NONE Result: NUMBER 

PI 

Gives the value of PI (n) to 15 digits. 

Example 1:. PI -+ 3.14159275358979 

Example 2: PI * 6A2 -+ 113.097335529233 

This example returns the area of a circle with a radius of 6 units of 
measurement. 
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( ROUND] Argument Type: NUMBER Result: INTEGER 

ROUND(Number) 

ROUNDs Number to the nearest integer value. 

• If Number contains a fraction in the range 0 ... to .499 ... then 
Number will be rounded down. 

• If Number contains a fraction in the range .5 ... to .999 ... then 
Number will be rounded up. 

• If Number is negative and contains a fraction in the range 0 to 
.499 ... then Number will be rounded up to the nearest whole 
negative number. 

• If Number is negative and contains a fraction in the range .5 to 
.999 ... then Number will be rounded down to the nearest whole 
negative number. 

Example: ROUND(5.499981) -+ 5 

( SQRT ] Argument Type: NUMBER Result: NUMBER 

SQRT(Number) 

The SQRT function computes the square root of Number. 

• You are not allowed to compute the SQRT of a negative number -
any attempt to do so will result in an error message. 

Example: SQRT(100) -+ 10 



ARITHMETIC 
FUNCTIONS 
(with a variable 
number of 
arguments) 

I 

Functions 

The general fonns for these functions are: 

• Function _ Name(formula FROM query) 

• Function _ Name(formula, formula, formula, .•... ) 

[nUERRGE] Argument Type: LIST OF NUMBERS Result: NUMBER 

[ COUNT] 

Gives the A VERAGE value of the List of Numbers. 

Example 1: A VERAGE(2,5,3,3) -+ 3.25 

Example 2: AVERAGE(salary FROM employee) -+ $39131.66 

This example returns the average of all the salaries paid to 
employees stored in the Employee database file. 

Argument Type: LIST Result: INTEGER 

COUNT(List) 

Gives the COUNT of the List. This function deals with how many 
list values exist, it is not concerned with the actual list item values 
themselves. The List may also be a query. 

Example 1: COUNT(1,2,3,4,5) -+ 5 

Example 2: COUNT(employee) -+ 15 

This example returns the total number of employees stored in the 
Employee database by counting the number of records. 
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( FU ) Argument Type: NUMBER, NUMBER, NUMBER Result: NUMBER 

FV (Payment, Interest_Rate, Periods) 

Returns the Future Value of the Payment compounded at the given 
Interest Rate, for the specified number of Periods. 

Example: FV(1000, .1, 10) ~ $2593.74 

( MRH ) Argument Type: LIST OF NUMBERS Result: NUMBER 

( MIN) 

MAX(List _ of_Numbers) 

Gives the MAXimum value, or largest number, that exists in the List 
of Numbers. Opposite of next function, MIN. 

Example 1: MAX(30,23,89,45) ~ 89 

The maximum value in the list. 

Example 2: MAX(salary FROM employee) ~ $54000 

The maximum salary earned by an employee in the Employee 
database file. 

Argument Type: LIST OF NUMBERS Result: NUMBER 

MIN (List _of_Numbers) 

Gives the MINimum value, or smallest number, that exists in the 
List of Numbers. See previous function, MAX. 

Example 1: MIN(30,23,89,45) ~ 23 
Example 2: MIN(salary FROM employee) ~ $28250 



Functions 

[ MOD) Argument Types: NUMBER, NUMBER Result: NUMBER 

MOD (Number, Modulus) 

If both Number and Modulus are positive, MOD returns the 
remainder when Number is divided by Modulus. 

If both Number and Modulus are negative, MOD returns the 
negative of the remainder. 

If the Modulus is positive and Number is Negative the Modulus is 
added to the remainder so that the Result is between zero and 
Modulus minus 1. 

If the Modulus is negative and the Number is positive then the 
negative of the Modulus is added to the remainder so that the Result 
lies between .the Modulus + 1 and zero. 

• Any attempt to divide the first Number by zero will result in an 
error message. 

• The result will have the same sign as the second Number. 

Example: 1 MOD(20, 5) -+ 0 

Example 2: MOD(l8, -5) -+ -2 

Example 3: MOD(-5, 4) -+ 3 

Example 4: MOD(-5, -4) -+ -1 
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( NPU ] 
Argument Types: LIST OF NUMBERS Result: NUMBER 

NPV(Interest_Rate, List_of_Numbers) 

Calculates the Net Present Value (today's value) of specific amounts 
of money (the List of Numbers) you will receive in the future based 
on some specific Interest Rate. 

• The Interest Rate is expressed in decimal fashion (.1 for 10%, .27 
for 27%, etc). 

• There are Numbers in the List of Numbers, representing the 
income over one or more Interest Rate periods. 

The example below is designed to show if it would be better to take 
a lump sum payment of $10,000 now or have $12,000 paid to you 
in $2,000 amounts over the next six years with an assumed inflation 
rate of 10%. 

Example: NPV(.l, 2000, 2000, 2000, 2000, 2000, 2000) ...... 
$9533.08 

( PMT ] Argument Type: NUMBER, NUMBER, NUMBER Result: NUMBER 

PMT(Principal, Interest_Rate, Period) 

Computes the amount of each payment required to pay back a loan 
based on the Principal owed, the Interest Rate being charged, and 
the number of payment Periods. 

Example: PMT(5000, .01,48) ...... $131.67 



Functions 

( PU ) Argument Type: NUMBER, NUMBER, NUMBER Result: NUMBER 

PV(Payment, Interest_Rate, Period) 

The present value of Payment discounted for the numbers of 
payment Periods at the specified Interest Rate. 

Example: PV(1000, .1, 10) -. $385.54 

( STDEU) Argument Type: LIST OF NUMBERS Result: NUMBER 

( SUM) 

STDEV(List_of_Numbers) 

Gives the STandard DEViation of the List of Numbers. 

Example: STDEV(43,23,81) -. 29.461839 .... 

Argument Type: LIST OF NUMBERS Result: NUMBER 

SUM(List_ of_Numbers) 

Gives the SUM of the List of Numbers. 

Example 1: SUM( 40,30,35) -. 105 

Example 2: SUM(salary FROM employee) -. $586975 

This example returns a total of all the salaries paid to employees in 
the Employee database file. 
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TRIGONOMETRIC 
FUNCTIONS 

For all trigonometric functions the angle is represented 
in radians, where a full circle of 360 degrees is 2*PI 
radians. . 

( AlA N ) Argument Type: NUMBER Result: ANGLE NUMBER 

( COS) 

( SIN) 

302 

ATAN(Number) 

Gives the ArcTANgent of Number. This is the angle for which the 
TAN is the given value, ie: ATAN(TAN(x)) = x. 

Example: ATAN(l) ..... .785398163397448 

Argument Type: ANGLE NUMBER Result: NUMBER 

COS(Angle_Number) 

Gives the COSine of Angle Value. 

Example: COS (PI/3) ..... .5 

Argument Type: ANGLE NUMBER Result: NUMBER 

SIN(Angle _Number) 

Gives the SINe of Angle Number. 

Example: SIN(PI/6) ...... 5 



Functions 

( TR N ) Argument Type: ANGLE NUMBER 

TAN(Angle_Number) 

Result: NUMBER 

Gives the TANgent of Angle Number. 

Example: TAN(PI/4) -+ 1 

DATE FUNCTIONS 

( DATE) Argument Types: INTEGER,INTEGER,INTEGER Result: DATE 

DA TE(Year _ value, Month_value, Day_value) 

The DATE function allows you to manipulate date values. 

Example 1: DATE(82,3,21) -+ 3/21/82 

This example shows how integer values may be converted to a Date. 

Example 2: 
DATE(YEAR(TODAY)+l, MONTH(TODAY),DAY(TODAY)) -+ 9/25/86 

This example shows how you can produce a date one year ahead of 
Today's date, which is September 25,1985. (The TODAY function 
obtains the date information from the Macintosh system 
clock/calendar). 
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( YERR ) Argument Type: DATE Result: INTEGER 

( MONTH) 

( DRY) 

YEAR(Date _ Value) 

The YEAR function extracts the year value as an integer from Date 
Value so that you can view it or apply mathematical operations to it. 

• The "@" symbol must precede all date constants in formulas. 
, 

Example: YEAR(@6/27/46)+40 -+ 1986 

Argument Type: DATE Result: INTEGER 

MONTH(Date _ value) 

The MONTH function extracts the month value as an integer from 
Date Value so that you can view it or apply mathematical operations 
to it. 

• The "@" symbol must precede all date constants in formulas. 

Example: MONTH(@6/27/45)+2 -+ 8 

Argument Type: DATE Result: INTEGER 

DAY(Date_ Value) 

The DA Y function extracts the day value as an integer from Date 
Value so that you can view it or apply mathematical operations to it. 

• The "@" symbol must precede all date constants in formulas. 

Example: DA Y(@6/27/45) -+ 27 



Functions 

( TI ME ) Argument Types: INTEGER, INTEGER, INTEGER Result: TIME 

( HOUR) 

(MINUTE) 

TIME(Hour _Integer , Minute_Integer, Second_Integer) 

• The TIME function allows you to manipulate time values. 

Example: TIME(9,3,2) ..... 9:03:02 

The .example shows how integer values may be converted to a Time. 

Argument Type: TIME Result: INTEGER 

HOUR(Time_ Value) 

The HOUR function extracts the hour value as an Integer from Time 
Value so that you can view it or apply mathematical operations to it. 

• The "@" symbol must precede all time constants in formulas. 

Example: HOUR(@ 11 :22:54) ..... 11 

Argument Type: TIME Result: INTEGER 

MINUTE(Time _ Value) 

The MINUTE function extracts the month value as an integer from 
Time Value so that you can view it or apply mathematical operations 
to it. 

• The "@" symbol must precede all time constants in formulas. 

Example: MINUTE(@11:22:54) ..... 22 
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( SECOND) Argument Type: TIME Result: INTEGER 

( TODAY) 

( NOW) 

SECOND(Time_ Value) 

The SECOND function extracts the second value as an integer from 
Time Value so that you can view it or apply mathematical operations 
to it. 

• The "@" symbol must precede all time constants in formulas. 

Example: SECOND(@11:22:54) -+ 54 

Argument Type: NONE Result: DATE 

TODAY 

Obtains today's date from the Macintosh system clock/calendar and 
will therefore only be as accurate as the settings of your Macintosh 
clock/calendar. 

Example: TODAY -+ 11/20/85 

Argument Type: NONE Result: TIME 

NOW 

The NOW function obtains the current time from the Macintosh's 
system clock and will therefore only be as accurate as the setting of 
your Macintosh system clock. 

Example: NOW -+ 10:52:21 



SPECIAL 
FUNCTIONS 

Functions 

( ERROR) Argument Type: NUMBER Result: ERROR 

ERROR(Error _Number) 

Generates a specific Reflex error message, dependent on the value 
of Error Number. 

• The error number can be chosen from the range 0 - 42 (see the 
section on Error Messages). 

Example 1: 

" File Edit Format Describe Report Fonts Style Wi 

§D 
[X] f 1 

function_report 

IF(Testfield = 100;That's OK",ERROR(O» 

· . . . . . .. . 
....... ~ .. T e ~ t fie 1 ?: .... C·.·.·.·.·.·.·.·.·.·.·.·.·.~.:·.·.·.·.·.·.·.·.·.:·.·.·.~ ............. : .............. ~.: ...................... ·.·.~.·.·.·.:·.·.·.·.·.·.·.·.·.~·.9.1· ... j ....... j . . . . . .. . .... . 

...... ~rror !est: ....... 1 ERR?RI .... j ....... j ............ . 
· . . . . . · . . . . . 

ERROR(O) is used as a general error indicator. 

Example 2: 

" File Edit Format Describe Report Fonts Style Wir 

§D Function_Report 
IX] f 1 ERROR( 1 1) 

....... · ...... 1 
ERROR( 11 ;'Wrong Type of Argument .. )I .. T .. · .. · ....... 

ERROR(ll) generates a specific error message 

307 



308 

( E H I STS) Argument Type: ANY Result: LOGICAL 

EXISTS(Name or Query) 

The EXISTS function can be used in two ways. It can check to see 
if a field has a non-blank value. It can also be used to check if there 
is at least one record in a database file or repeating collection that 
meets a qualification. 

Example 1: 
EXISTS(employee WHERE LENGTH(LastName) = 6) -+ TRUE 

This example checks a database file called Employee for any records 
that have a LastName field that contains a value with exactly six 
characters. If it finds one, it does not return the field value - it just 
returns TRUE. If no records had met the criteria, then EXISTS 
would have returned a value of FALSE. 

Example 2: COUNT(employee WHERE EXISTS(Homephone)) 

This example gives the count of people in a database file called 
Employee who have a value in the Homephone field (the Employee 
file supplied with Reflex does not have a Homephone field, but you 
can add one if you wish). 

FRLSE Argument Type: NONE Result: LOGICAL 

FALSE 

Can be used within a formula to indicate that a condition has a value 
of FALSE. See NO, YES, and TRUE for companion functions. 

Example: FALSE -+ FALSE 



Functions 

[ ___ I_F __ J Argument Types: LOGICAL, ANY, ANY Result: ANY 

IF(Condition, Then_Formula, Else_Formula) 

If Condition is true, return Then Formula. If Condition is false, 
return Else Formula. 

• The True and False formulas may be any Reflex formulas. 

Example: IF(100 < 200,"Correct","Incorrect") -+ Correct 

[I SERROR J Argument Type: Any Result: LOGICAL 

[ I SNR J 

ISERROR(Formula) 

Returns TR VE if the value of the Argument is one of the defined 
Reflex Error values. 

Argument Type: Any Result: LOGICAL 

ISNA(Formula) 

Returns TR VE if the value of the Argument is N A. 
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[LOOKUP) Argument Type: Formula FROM Query Result: ANY 

[ NR ) 

LOOKUP(Formula FROM Query) 

The LOOKUP function finds the first record from the query that 
meets its qualification and computes the formula for that record and 
then returns the computed value. If no record is found that meets the 
qualification the LOOKUP function returns NA. 

Example 1: LOOKUP(netWorth FROM person WHERE 
FirstName = "Mark") -+ $400000 

Example 2: 
LOOKUP(FirstName&" "&LastName FROM 

person WHERE 
city = "Los Altos") -+ Mark Hoffman 

This example will return a concatenated field (made up of the 
FirstName and LastName fields) for each person in the Person 
database file that lives in Los Altos. 

Argument Type: NONE Result: NA 

NA 

Used to generate the Not Available indicator. 

Example: NA -+ NA 



I 

Functions 

NO Argument Type: NONE 

NO 

Result: Logical 

[PREUIOUS) 

Can be used within a formula to indicate a negative condition - the 
NO function is equivalent to the FALSE function. Also see YES and 
TRUE. 

Example: NO -+ NO 

Argument Type: NONE Result: ANY 

PREVIOUS 

The PREVIOUS function only works within repeating collections. It 
allows you to obtain a running calculation of various field values 
included in a repeating collection. 

• The Total field shown below will produce a running total of the 
salary field in the repeating collection and contains the formula: 
Salary + PREVIOUS. 

Example: 

'* File Edit Format Describe Report Fonts Style Window 

D Function Report 

!Xl f3 salary+PREVIOUS 

Salary + Previous: 

r·· .. ·················································· ................. ': 
Report Display 
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TRUE Argument Type: NONE Result: LOGICAL 

YES 

TRUE 

Can be used within a fonnula to indicate that a condition is TRUE. 
See YES, FALSE, and NO for companion functions. 

Example: TRUE -+ TRUE 

Argument Type: NONE Result: LOGICAL 

YES 

Can be used within a fonnula to indicate an affirmative condition­
the YES function is equivalent to the TRUE function. Also see NO 

and FALSE. 

Example: YES -+ YES 



Reflex Error Messages 

REFLEX ERROR MESSAGES 

ERROR(l,"Text Result Required") 

This error message occurs when you attempt to display a non-text 
result in a field of type Text. 

ERROR(2,"Numeric Result Required") 

This error message occurs when you attempt to display a non­
numeric result in a field of type Number or Integer. 

ERROR(3, "Date Result Required") 

This error message occurs when you attempt to display a non-date 
result in a field of type Date. 

ERROR(4, "Logical Result Required") 

This error message occurs when you attempt to display a non-logical 
result in a field of type Logical. 

ERROR(5, "Time Result Required") 

This error message occurs when you attempt to display a non-time 
result in a field of type Time. 

ERROR(6, "Text Argument Required") 

This error message occurs when a Text argument is required but you 
have supplied some other argument type. 

ERROR(7, "Numeric Argument Required") 

This error message occurs when a Numeric argument is required but 
you have supplied some other argument type. 
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ERROR(8, "Date Argument Required"} 

This error message occurs when a Date argument is required but you 
have supplied some other argument type. 

ERROR(9, "Logical Argument Required"} 

This error message occurs when a Logical argument is required but 
you have supplied some other argument type. 

ERROR(lO, "Time Argument Required"} 

This error message occurs when a Time argument is required but 
you have supplied some other argument type. 

ERROR(ll, "Wrong Type of Argument"} 

This error message occurs when a specific argument is required but 
you have supplied some other invalid type. 

ERROR(12, "Reference to Error Value"} 

This error message occurs when you refer to an object that contains 
a value of type ERROR. 

ERROR(13, "Missing Arguments"} 

This error message occurs when one or more arguments are missing 
from a formula. 

ERROR(14, "SQRT Argument Negative"} 

This error message occurs when you try to obtain the square root of 
a negative number. 

ERROR(15, "+ or - Arguments Infinite"} 

This error message occurs when you attempt to add -INFINITY to 
INFINITY or subtract INFINITY from INFINITY. 



Reflex Error Messages 

ERROR(16, ,,/ Arguments Invalid"} 

This error message occurs when you attempt an invalid division 
operation (eg: 0 / 0 or INFINITY / INFINITY). 

ERROR(17, "* Arguments Invalid"} 

This error message occurs when you attempt an invalid 
multiplication operation (eg: 0 * INFINITY). 

ERROR(18, "MOD Argument Zero"} 

This error occurs when you attempt supply the MOD function with a 
zero argument. 

ERROR(19, "SIN, COS or TAN Argument Infinite"} 

This error message occurs when you attempt an invalid operation 
with one of these functions such as: SIN(lNFINITY) or SIN(­
INFINITY). 

ERROR(20, "LOG or LN Argument Negative"} 

This error message occurs when you attempt to use either function 
with a negative number. 

ERROR(21, "A Argument Invalid"} 

This error message occurs when you attempt an invalid operation 
with this function such as: -3 1\ .5 

ERROR(22, "NPV, PV, FV, PMT Interest Argument 
Invalid"} 

This error message occurs when you supply an invalid NPV interest 
rate argument to one of these function, such as: NPV(-2,4,4) 
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ERROR(23, "Number too large for Integer") 

This error message occurs when you compute a number that is too 
large to be handled by an Integer type field. 

ERROR(24, "Name not found") 

This error message occurs when you supply a Name Reference and 
the name you refer to does not exist, or is not available on currently 
mounted disks. 

ERROR(25, "Circular Reference") 

This error message occurs in a number of ways: 

• When you have a field refer to itself. 

• When you have field A refer to field B and field B refer to field 
A. 

• When you have field A refer to field B, field B refer to field C, ... 
refer to field X, and field X refer to field A. 

ERROR(26, "Reference is not a valid Source") 

This error message occurs when you attempt to make a reference to 
a component of something that is not a Source (a field, for example) 
and therefore has po components. 

ERROR(27, "Name not found in Source"} 

This error message occurs when you use a correct reference to a 
component of a Source, but the component you specify does not 
actually exist. 

ERROR(28, "Empty Link") 

This error message occurs when you make a correct reference to a 
component of a Link and that Link contains nothing - it is empty. 



Reflex Error Messages 

ERROR(29, "Invalid Reference to Link Collection"} 

This error message occurs when you make a correct reference to a 
component of a Link Collection as if it were just a simple Link - the 
Link Collection contains many Links and you have just asked for an 
unspecified single value. 

ERROR(30, "Linked Record not found") 

This error message occurs when you reference a link and the linked 
record is not found. The message will appear when the Links 
between records are inconsistent (corrupted) in some way. 

ERROR(31, "MID or REPEAT Argument Invalid"} 

This error message occurs when you use a negative Number 
argument with either function, such as: MID("Hello", 2, -2}. 

ERROR(32, "DATE Argument Invalid"} 

This error message occurs when you attempt to use an invalid date 
argument with the DATE function such as: 

DATE(1985,99,3) 

This example has a bad second argument for the month. 

ERROR(33, "TIME Argument Invalid"} 

This error message occurs when you attempt to use an invalid time 
argument with the TIME function such as: 

TIME( -8,45,0) 

This example has a bad first argument for the hour. 

ERROR(34, "Query used incorrectly"} 

This error message occurs when you use a Query in the wrong 
place, or context such as: 

3+Person WHERE Networth > 10000. 
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ERROR(35, "Query required") 

This- error message occurs when you needed to use a Query but did 
not supply one, such as: 

LOOKUP (Networth FROM 12). 

ERROR(36, "Source Reference Required") 

This error message occurs when you needed to supply a reference to 
a Source, but did not do so, such as: 

LOOKUP (Networth FROM StockReport). 

ERROR(37, "Empty Repeating Collection") 

This error message occurs when you attempt to calculate a report 
that includes a repeating collection that does not contain anything for 
displaying the report contents. 

ERROR(38, "Not Implemented") 

This error message occurs when you attempt to use a new feature 
not supported in this version of Reflex. 

ERROR(39, "Damaged Formula") 

This error message occurs when the internal representation of a 
formula has been corrupted. This is a very severe error and should 
be reported to Borland International. 

ERROR(40, "Unknown Arithmetic Problem") 

This error message occurs when Reflex cannot detect the specific 
nature of an arithmetic problem. This is a very severe error and 
should be reported to Borland International. 



Reflex Error Messages 

ERROR(41, "Unknown Calculation Problem") 

This error message occurs when there has been some unspecified 
internal Reflex problem in calculation. This is a very severe error 
and should be reported to Borland International. 

ERROR(42, "LOOKUP returned Not Available") 

This error message occurs when you use the LOOKUP function in a 
Record Qualification Formula in a database window and it does not 
return the value of TRUE or FALSE - the value(s) you wanted were 
Not Available (i.e. NA). 
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General 

Database Design 

Visual Layout 
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> Runs on any 512K + Mac, Mac XL or Macintosh Plus 
> Runs under the Switcher with minimum 300K partition 
> Uses additional memory as database buffers for increased 

performance 
> Context sensitive Help facility 
> Hard disk install 

> Fully Relational, multiple file database 
> Maximum field length: 1002 bytes 
> Maximum fields per record: 254 
> Maximum record length: 1008 bytes 
> Maximum records per file: limited only by capacity of disk 
> Number of open files: 15 
> Design of a database file, its fields, and Links to other files 

through visual layout of file images on the Database 
. Overview 

> Database fields can be Text, Number, Integer, Date, Time, 
Logical, or Sequence Number data types. 

> Links between files (1-1, I-many, many-many) are defined by 
simply drawing lines between database file images. 

> Can add, delete, rename, reorder, and change types of fields and 
Links, with automatic restructuring of data. 

> Multi-field keys. 

> Visual layout of the data entry form and report design allowed 
> Change size, shape and position of fields 
> Add, edit, and/or move text labels 
> Paste pictures from Clipboard into data entry form or report 

design 
> Alignment and formatting of objects. 
> Grid shown on screen with automatic alignment to grid to 

simplify layout 
> Display format for numbers: General, Decimal, Scientific, 

Dollars, Percent with Digits and Commas. 
> Display format for dates: Short, Long, and Abbreviated. 
> Complete selection of Macintosh fonts, sizes and styles 



Data Entry 

Report 
Generation 

Reflex Oata Sheet 

> Data entry fonn can be customized using Visual Layout 
> QueryBuild feature can be used to easily retrieve records based 

on qualification of values of database fields combined with 
AND and OR. 

> User can perfonn more complex retrievals by entering arbitrary 
fonnulas 

> Automatically checks for data of correct type for each field 
> User can define more specialized data checks for each field. 
> Consistency of Links between files is automatically maintained 

(i.e. checks that mentioned record exists) 
> Export/lmport data to/from Text files 
> Supports Export of data for mail merge operations. 

> Automatic generation of simple table-style reports for a database 
file 

> Reports can also be designed using Visual Layout 
> Can reference values in database files by using relational 

database functions and operators 
> Can reference values in other reports 
> Computed fields with full set of logical, arithmetic, date, time, 

statistical, comparison, and text functions and operators 
> Summary Functions (i.e. COUNT, SUM, AVERAGE, MIN, 

MAX, STDEV and NPV) can be perfonned 
> QueryBuild feature can be used in reports to help construct 

database record qualifications 
> Natural order of evaluation (includes references to other reports) 
> Repeating Collections allow the calculation of arbitrary values to 

be perfonned for each specified record of a database file. 
> Report layout automatically modified to allow display of these 

multiple calculated values in Repeating Collections 
> Repeating Collections include as a special case nested control 

breaks with arbitrary summary calculations 
> Sorting by multiple values of each Repeating Collection level 
> Headers, Footers and control over Page breaks 
> Print report to Screen, to Printer, or Export to Text file (can then 

be Imported back into database file to add or update data 
records) 

> Print quality: Draft, Standard, & High Resolution 
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> Rapid browsing through a database. Press Command-Shift N (or 
hold down Shift while selecting Next Record from the Search menu) to 
scroll 10 qualified records forward through the database. To scroll 
backward, press Command-Shift P (or hold down Shift while selecting 
Previous Record from the Search menu). 

> Griding by fractions of an inch. Major grid divisions occur every 
half inch. Grid points for alignment occur every eighth inch. 

> Finding help under HFS. Under HFS, Reflex looks for the help 
file first in the Reflex folder, then in the executed volume, and finally in 
all mounted volumes. 

> Bumping sequence numbers when Make Copy of Record is chosen. 

> New option in Overview Menu: Change File Destination. 
This will create a new version of the database on the chosen volume and 
then delete the old version of the database. 

> Faster selecting of groups of objects in form design. Press 
the option key and drag a "lasso" box similar to Finder's. Release the 
mouse to select all objects completely enclosed by the box. 

> Additional operations on a group of selected objects. You 
can perform the following operations on a group of selected fields: field 
type changes, display format changes, font changes, style changes, protect 
(unprotect) objects, and text alignment. 

> Controlling page breaks in repeating collections. Select a 
repeating collection and choose No Page Breaks from the Describe menu. 

> Supporting non-standard paper sizes. Use the Paper Sizes 
command from the File menu to customize page sizes. This information 
will be valid for all printers except the LaserWriter, which uses the 
system's page size information. 

> Supporting custom import/export files. Select the Custom 
Text File button in the first export or import dialog box. 

> Second LOOKUP argument. The LOOKUP function now accepts 
an optional second argument. NA will be returned as the default if a 
second argument is not specified. For example, 
LOOKUP(Amount FROM Order WHERE Name=" -none-" ,0) 
return the value zero. 

> WEEKDAY function. This function takes a date argument and 
returns an integer for the corresponding day of the week (1 for Sunday, 2 
for Monday, 3 for Tuesday, and so forth). For example, 
WEEKDAY (@1217/41) returns 1 since Dec. 7, 1941, was a Sunday. 

> Date/Time arithmetic. The following expressions involving dates, 
time values, and integers are now supported: date - date, date 
+ integer, date - integer, time - time, time + integer, time - integer 
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SlDllla" 
Whether you're running WordStar,® Lotus,® dBASE,® 

or any other program, SideKick puts all these desktop 
accessories at your fingertips-Instantly 

A full-screen WordStar-like Editor to jot 
down notes and edit files up to 25 pages long. 

A Phone Directory for names, addresses, and 
telephone numbers. Finding a name or a 
number is a snap. 

An Autodialer for all your phone calls. It will 
look up and dial telephone numbers for you. 
(A modem is required to use this function.) 

All the SideKick windows stacked up over Lotus 1-2-3." 
From bottom to top: SideKick's "Menu Window," ASCII 
Table, Notepad, Calculator, Appointment Calendar, Monthly 
Calendar, and Phone Dialer. 

A Monthly Calendar from 1901 through 2099. 

Appointment Calendar to remind you of 
important meetings and appointments. 

A lull-Ieatured Calculator ideal for business 
use. It also performs decimal to hexidecimal to 
binary conversions. 

An ASCII Table for easy reference. 

Here's SideKick running over Lotus 1-2-3. In the SideKick 
Notepad you'll notice data that's been imported directly 
from the Lotus screen. In the upper right you can see the 
Calculator. 

The Critics' Choice 
"In a simple, beautiful implementation of WordStar's 
block copy commands, SideKick can transport all or 
any part of the display screen (even an area overlaid 
by the notepad display) to the notepad." 

-Charles Petzold, PC MAGAZINE 

"SideKick deserves a place in every PC." 
-Gary Ray, PC WEEK 

"SideKick is by far the best we've seen. It is also the 

least expensive·'Ron Mansfield, ENTREPRENEUR 

"If you use a PC, get SideKick. You'll soon become 
dependent on it." -Jerry Pournelle, BYTE 

Suggested Retail Price: $54.95 (copy protected); $84.95 (not copy protected) 

Minimum system configuration: IBM PC, XT, AT, PCjr and true compatibles. The IBM PCjr will only accept the 
SideKick not-copy-protected versions. PC-DOS 2.0 (MS-DOS) or greater. 128K RAM. One disk drive. A Hayes-compatible modem, 
IBM PCjr internal modem, or AT&T Modem 4000 is required for the autodialer function. 

SideKick is a registered trademark 01 Borland International, Inc. dBASE is a registered trademark 01 
Ashton-Tate. IBM, XT, AT, and PCjr are registered trademarks 01 International Business Machines Corp. 
AT&T is a registered trademark 01 American Telephone & Telegraph Company. Lotus and 1-2-3 are 
registered trademarks of Lotus Development Corp. WordStar is a registered trademark of MicroPro 
International Corp. Hayes is a trademark of Hayes Microcomputer Products, Inc. BOR 0060A 



SideKick, The Macintosh Office Manager,TM brings 
information management, desktop organization, and 
telecommunications to your Macintosh.TM Instantly, 

while running any other program 

A full-screen editor/mini-word processor 
lets you jot down notes and create or edit 
files. Your files can also be used by your 
favorite word processing program, like 
MacWrite" or Microsoft8 Word. 

A complete telecommunications program 
sends or receives information from any 
on-line network or electronic bulletin 
board while using any of your favorite 
application programs. 

A full-featured financial and scientific 
calculator sends a paper -tape output to 
your screen or printer and comes 
complete with function keys for financial 
modeling purposes. 

A print spooler prints any "text only" file 
while you run other programs. 

A versatile calendar lets you view your 
appointments for a day, a week, or an 
entire month. You can easily print out your 
schedule for quick reference. 

A convenient "Things-to-Do" file reminds 
you of important tasks. 

A convenient alarm system alerts you to 
daily engagements. 

PhoneLink allows you to autodial any 
phone number, as well as acces any long­
distance carrier (modem required). 

A phone log keeps a complete record of all 
your telephone activities. It even computes 
the cost of every call. 

Area code look-up provides instant access 
to the state, region, and time zone for all 
area codes. 

An expense account file records your 
business and travel expenses. 

A credit card file keeps track of your credit 
card balances and credit limits. 

A report generator prints out your mailing 
list labels, phone directory, and weekly 
calendar in convenient sizes. 

A convenient analog clock with a sweeping 
second-hand can be displayed anywhere 
on your screen. 

On-line help is available for all of the 
" powerful SideKick features. 

Best of all, everything runs concurrently 

Suggested Retail Price: $99.95 (not copy protected) 

Minimum system configuration: 128K RAM and one disk drive. Two disk drives are recommended If you wish to use other 
application programs. HFS compatible. 

SideKick is a registered trademark and PhooeLink is a trademark of Borland International. Inc. 
Macintosh is a trademark of Mcintosh Laboratory, Inc. licensed to Apple Computer, Inc. 
MacWrite is a trademark of Apple Computer, Inc. Microsoft Word is a registered trademark of 
Microsoft Corp. 

BOR0069A 



The Organizer For The Computer Age! 
Traveling SideKick is BinderWare;M both a binder you take with you when you travel 
and a software program-which includes a Report Generator-that generates and 

prints out all the information you'll need to take with you. 

Information like your phone list, your client list, 
your address book, your calendar, and your 
apPointments. The appointment or calendar files 
you're already using in your SideKicke can auto­
matically be used by your Traveling SideKick. You 
don't waste time and effort reentering information 
that's already there. 

One keystroke prints out a form like your address 
book. No need to change printer paper; 

What's inside Traveling SideKick 

*Suggested Retail Price: $69.95 

you simply punch three holes, fold and clip 
the form into your Traveling SideKick binder, and 
you're on your way. Because Traveling SideKick is 
CAD (Computer-Age Designed), you don't fool 
around with low-tech tools like scissors, tape, or 
staples. And because Traveling SideKick is 
electronic, it works this year, next year, and all the 
"next years" after that. Old-fashioned daytime 
organizers are history in 365 days. 

What the software program and its 
Report Generator do for you before 
you go-and when you get back 

Before you go: 
• Prints out your calendar, 

appointments, addresses, phone 
directory, and whatever other 
information you need from your 
data files 

When you return: 
• Lets you quickly and easily enter all 

the new names you obtained while 
you were away into your 
SideKick data files 

It can a/so: 
• Sort your address book by contact, 

zip code or company name 
• Print mailing labels 
• Print information selectively 
• Search files for existing addresses 

or calendar engagements 

Minimum system configuration: IBM PC, XT, AT, Portable, PCjr, 3270 and true compatibles. PC-DOS (MS-DOS) 2.0 or later. 
256K RAM mimlmum. 

·Speclal introductory oHer 

SideKick and Traveling SideKick are registered trademarks and BinderWare is a trademark of 
Borland International, Inc. IBM, AT, XT, and PCjr are registered trademarks of International 
Business Machines Corp. MS-DOS is a registered trademark of Microsoft Corp. BOR 0083 



SUlerler e 

INCREASE YOUR PRODUCTIVITY 
BY 50% OR YOUR MONEY BACK 

SuperKey turns 1,000 keystrokes into 11 
Yes, SuperKey can record lengthy keystroke sequences and play them back at the touch of a 
single key. Instantly. Like magic. 
Say, for example, you want to add a column of figures in 1-2-3.- Without SuperKey, you'd 
have to type 5 keystrokes just to get started: @ sum ( . With SuperKey, you can turn those 
5 keystrokes into 1. 

SuperKey keeps your confidentialfiles-CONFIDENTIALI 
Time after time you've experienced it: anyone can walk up to your PC and read your 
confidential files (tax returns, business plans, customer lists, personal letters, etc.). 
With SuperKey you can encrypt any file, even while running another program. As long as you 
keep the password secret, only YOU can decode your file. SuperKey implements the U.S. 
government Data Encryption Standard (DES). 

SuperKey helps protect your capital investment 
SuperKey, at your convenience, will make your screen go blank after a predetermined time of 
screen/keyboard inactivity. You've paid hard-earned money for your PC. SuperKey will 
protect your monitor's precious phosphor and your investment. 

SuperKey protects your work from intruders while you take a break 
Now you can lock your keyboard at any time. Prevent anyone from changing hours of work. 
Type in your secret password and everything comes back to life-just as you left it. 

Suggested Retail Price: $69.95 (not copy protected) 

Minimum system conflguntlon: IBM PC, Xl, AT, PC)r and true compatllln. PC·DOS (MS·DOS) 2.0 or greater. 128K RAM. One disk drive. 

SuperKey is a registered trademark of Borland International. Inc. IBM. XT. AT. and PCjr are registered 
trademarks of International Business Machines Corp. 1-2-3 is a registered trademark of Lotus 
Development Corp. 

BOR0062A 



If you use an IBM® PC, you need 

T U R B 0 

Lightning@ 
Turbo Lightning teams up 
with the Random House@ 
Concise Dictionary to 
check your spelling as 
you type! 

Turbo Lightning, using the 
83,OOO-word Random House 
Dictionary, checks your spelling 
as you type. If you misspell a 
word, it alerts you with a beep. 
At the touch of a key, Turbo 
Lightning opens a window on 
top of your application pro­
gram and suggests the correct 
spelling. Just press one key 
and the misspelled word is 
instantly replaced with the 
correct word. It's that easy! 

Turbo Lightning works 
hand-in-hand with the 
Random House Thesaurus 
to give you instant access 
to synonyms 

Turbo Lightning lets you choose 
just the right word from a list of 
alternates, so you don't say the 
same thing the same way every 
time. Once Turbo Lightning 
opens the Thesaurus window, 
you see a list of alternate 
words, organized by parts of 
speech. You just select the 
word you want, press ENTER 
and your new word will in­
stantly replace the original 
word. Pure magic! 

If you ever write a 
word, think a word, or 
say a word, you need 
Turbo Lightning 

The Turbo Lightning Dictionary 

I he I urbo Lightning I hesaurus 

Suggested Retail Price: $99.95 (not copy protected) 

Turbo Lightning's 
intelligence lets you teach 
it new words. The more 
you use Turbo Lightning, 
the smarter it gets 

You can also teach your new 
Turbo Lightning your name, 
business associates' names, 
street names, addresses, 
correct capitalizations, and any 
specialized words you use 
frequently. T each Turbo 
Lightning once, and it 
knows forever. 

Turbo Lightning 
is the engine that 
powers Borland's Turbo 
Lightning Library" 

Turbo Lightning brings 
electronic power to the Random 
House Dictionary and Random 
House Thesaurus. They're at 
your fingertips-even while 
you're running other programs. 
Turbo Lightning will also 
"drive" soon-to-be-released 
encyclopedias, extended 
thesauruses, specialized 
dictionaries, and many other 
popular reference works. 
You get a head start with this 
first volume in the Turbo 
Lightning Library. 

And because Turbo Lightning is 
a Borland product, you know 
you can rely on our quality, our 
50-day money-back guarantee, 
and our eminently fair prices: 

Minimum system configuration: IBM PC, XT, AT, PCjr, and true compatibles with 2 floppy disk drives. PC-DOS (MS-DOS) 2.0 or greater. 
256K RAM. Hard disk recommended. 

BORLAND 
INTERNATIONAL 

IBM, XT, AT, and PCjr are registered trademarks of International Business Machines Corp. Turbo 
Lightning is a registered trademark and Turbo Lightning Library is a trademark of Borland 
International, Inc. Random House is a registered trademark of Random House Inc. BOR 0070A 



Your Development Toolbox and Technical Reference Manual for Thrbo Lightning 

l I G H T N I N G 

Lightning Word Wizard includes complete, commented Turbo PascaP source 
code and all the technical information you'll need to understand and work 

with Turbo Lightning's "engine." More than 20 fully documented Turbo 
Pascal procedures reveal powerful Turbo Lightning® engine calls. 

Harness the full power of the complete and authoritative Random House® 
Concise Dictionary and Random House Thesaurus. 

Turbo Lightning's "Reference Manua/" 
Developers can use the versatile on-line examples to 
harness Turbo Lightning's power to do rapid word 
searches. Lightning Word Wizard is the forerunner of 
the database access systems that will incorporate and 
engineer the Turbo Lightning Library'·of electronic 
reference works. 

The ultimate collection of word games and 
crossword solvers! 
The excitement, challenge, competition, and education 
of four games and three solver utilities-puzzles, 
scrambles, spell-searches, synonym-seekings, hidden 
words, crossword solutions, and more. You and your 
friends (up to four people total) can set the difficulty 
level and contest the high-speed smarts of Lightning 
Word Wizard! 

TURBO LIGHTNING-CRITICS' CHOICE 
"Lightning's good enough to make programmers and users cheer, executives of other software 
companies weep." Jim Seymour, PC Week 

''The real future of Lightning clearly lies not with the spelling checker and thesaurus currently included, but 
with other uses of its powerful look-up engine." Ted Silveira, Profiles 

"This newest product from Borland has it all." Don Roy, Computing Now! 

Minimum system configuration: IBM PC, Xl, AT, PCjr, Portable, and true compatibles. 256K RAM minimum. PC·DOS (MS· DOS) 2.0 or greater. Turbo lightning 
software required. Opllon81-Turbo Pascal 3.0 or greater to edit and compile Turbo Pascal source code. 

Suggested Retail Price: $69.95 

Turbo Pascal and Turbo Lightning are registered trademarks and Lightning Word Wizard and Turbo Lightning Library are trademarks 01 Borland International, Inc. Random House is.a registered trademark 
01 Random House, Inc. IBM, XT, AT, and PCjr are registered trademarks ollnternalional Business Machines Corp. MS-DOS is a registered trademark 01 Microsoft Corp. 

BOROOS7 



REFLEX@ 
THE ANALYST 

Reflex is the most amazing and easy-to-use database management 
system. And il you already use Lotus 1-2-3,@ dBASE,'~) or PFS: File/) 

you need Relle~-because it's a totally new way to look at your data. 
It shows you patterns and interrelationships you didn't know were 

there, because they were hidden in data and numbers. 
It's also the greatest report generator lor 1-2-3. 

REFLEX OPENS MULTIPLE WINDOWS WITH NEW VIEWS AND GRAPHIC INSIGHTS INTO YOUR DATA. 
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The FORM VIEW lets you build and examine your database. 
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The LIST VIEW lets you put data in tabular list form 
just like a spreadsheet. 
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The GRAPH VIEW gives you instant interactive 
graphic representations. 
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The CROSSTAB VIEW 
gives you amazing "cross­
referenced" pictures of the 
links and relationships hidden 
in your data. 
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So Reftex shows you-Instant answers. Instant pictures. Instant analysis. Instant understanding. 

THE CRITICS' CHOICE: 

The REPORT VIEW 
allows you to import 

and export to and from 
Rellex, 1-2-3, dBASE, 

PFS: File, and other 
applications, and prints 

out information in the 
formats you want. 

"The next generation of software has officially arrived." The program is easy to use and not intimidating to the novice ... 
Reflex not only handles the usual database functions such as 
sorting and searching, but also "what-if" and statistical analysis ... 
it can create interactive graphics with the graphics module. The 
separate report module is one of the best we've ever seen." 

Peter Norton, PC WEEK 

"Reflex is one of the most powerful database programs on the 
market. Its multiple views, interactive windows and graphics, great 
report writer, pull-down menus, and cross tabulation make this one 
of the best programs we have seen in a long time ... 

Suggested Retail Price $149.95 (not copy protected) 

Marc Stern, INFOWORLD 

Minimum system configuration: IBM PC, Xl, AT, and true compatibles. PC-DOS (MS·DOS) 2.0 or greater. 384K RAM minimum. IBM 
Color Graphics Adapter, Hercules Monochrome Graphics Card, or equivalent. Hard disk and mouse optl_l. Lotus 1-2-3, dBASE, or 
PfS: File optional. 

Reflex is a registered trademark of Borland/Analytica Inc. Lotus 1-2-3 is a registered trademark of 
Lotus Development Corporation. dBASE is a registered trademark of Ashton-Tate. PFS: File is a 
registered trademark of Software Publishing Corporation. IBM, Xl AT, and IBM Color Graphics 
Adapter are registered trademarks of International Business Machines Corporation. Hercules Graphics 
Card is a trademark of Hercules Computer Technology. BOR 0066A 



REFLEX 

Includes 22 "instant templates" covering a broad range 01 
business applications (listed below). Also shows you how to 

customize databases, graphs, cross tabs, and reports. It's an invaluable 
analytical tool and an important addition to another one 01 

our best sellers, Rellex: The Analyst 1.1. 

Fast-start tutorial examples: 
Learn Reflex as you work with practical business applications. The Reflex Workshop Disk supplies databases 
and reports large enough to illustrate the power and variety of Reflex features. Instructions in each 
Reflex Workshop chapter take you through a step-by-step analysis of sample data. You then follow simple 

. steps to adapt the files to your own needs. 
22 practical business applications: 
Workshop's 22 "instant templates" give you a wide range of analytical tools: 

Administration • Tracking Manufacturing Quality Assurance 
• Scheduling Appointments • Analyzing Product Costs 
• Planning Conference Facilities Accounting and Financial Planning 
• Managing a Project • Tracking Petty Cash 
• Creating a Mailing System • Entering Purchase Orders 
• Managing Employment Applications • Organizing Outgoing Purchase Orders 
Sales and Marketing • Analyzing Accounts Receivable 
• Researching Store Check Inventory • Maintaining Letters of Credit 
• Tracking Sales Leads • Reporting Business Expenses 

• Managing Debits and Credits 
• Summarizing Sales Trends • Examining Leased Inventory Trends 
• Analyzing Trends • Tracking Fixed Assets 
Production and Operations • Planning Commercial Real Estate Investment 
• Summarizing Repair Turnaround 

Whether you're a newcomer learning Reflex basics or an experienced "power user" looking for tips, Reflex 
Workshop will help you quickly become an expert database analyst. 

Minimum system configuration: I. PC, AT, and Xl, and true compatibles. PC-DDS (MS-DOS) 2.0 or greater. 384K RAM minimum. Requires Reflex: The 
Analyst, and IBM Color Graphics Adapter, Hercules Monochrome Graphics Card or equivalent. 

Suggested Retail Price: $69.95 
(not copy protected) 

Reflex is a registered trademark and Reflex Workshop is a trademark of Borland/Analytica, Inc. IBM, AT, and Xl are registered trademarks of International Business Machines 
Corp. Hercules is a trademark of Hercules Computer Technology. 

BORDO 



Turbo Prolog brings fifth-generation supercomputer 
power to your IBM®PC! 

Turbo Prolog takes 
programming into a new, 
natural, and logical 
environment 
With Turbo Prolog, 
because of its natural, 
logical approach, both 
people new to programming 
and professional programmers 
can build powerful applica­
tions such as expert systems, 
customized knowledge 
bases, natural language 
interfaces, and smart 
information management systems. 
Turbo Prolog is a declarative language 
which uses deductive reasoning to solve 
programming problems. 

Turbo Plolog's development system 
includes: 
o A complete Prolog incremental compiler 

that conforms to the Clocksin and Mellish 
Edinburgh standard Prolog. 

o A full-screen interactive editor. 
o Support for both graphic and text windows. 
o All the tools that let you build your own 

expert sytems and AI applications with 
unprecedented ease~ 

Turbo Prolog provides 
a fully integrated pro­
gramming environment 
like Borland's Turbo 
Pascal,® the de facto 
worldwide standard. 
You get the complete 
Turbo Plolog program­
ming system 
You get the 2DD-page 
manual you're holding, 
software that includes 
the lightning-fast TUlbo 
Prolog incremental 

compiler and interactive editor, and the free 
GeoBase natural query language database, 
which includes commented source code on 
disk, ready to compile. (GeoBase is a 
complete database designed and developed 
around U.S. geography. You can modify it 
or use it "as is.") 

Minimum system configuration: IBM PC, Xl, AT, Portable, 3270, PCjr 
and true compatibles. PC-DOS (MS-DOS) 2.0 or later. 384K RAM 
minimum. 

Suggested Retail Price $99.95 
(not copy protected) 

Turbo Prolog is a trademark and Turbo Pascal is a registered trademark of Borland International, Inc. IBM. 
AT, Xl and PCjr are registered trademarks of Internalional Business Machines Corp. MS-DOS is a 
registered trademark of Microsoft Corp. 

BOR0016B 



VERSION 3.0 with 8087 support and BCD reals 

Free MicroCaic Spreadsheet With Commented Source Code! 
FEATURES: 
One-Step Compile: No hunting & fishing 
expeditions! Turbo finds the errors, takes you 
to them, lets you correct them, and instantly 
recompiles. You're off and running in 
record time. 

Built-in Interactive Editor: WordStar~like 
easy editing lets you debug quickly. 

Automatic Overlays: Fits big programs into 
small amounts of memory. 

THE CRITICS' CHOICE: 
"Language deal of the century ... Turbo Pascal: 
it introduces a new programming environment 
and runs like magic." 

-Jell Duntemann, PC Magazine 

"Most Pascal compilers barely fit on a disk, but 
Turbo Pascal packs an editor, compiler, linker, 
and run-time library into just 39K bytes of 
random access memory." 

-Dave Garland, Popular Computing 

MicroCalc: A sample spreadsheet on your disk 
with ready-to-compile source code. 

"What I think the computer industry is headed 
for: well-documented, standard, plenty of 
good features, and a reasonable price." 

IBM® PC Version: Supports Turtle Graphics, 
color, sound, full tree directories, window 
routines, input/output redirection, and 
much more. 

-Jerry Pournelle, BYTE 

LOOK AT TURBO NOW! 

5J' More than 500,000 users worldwide. 

5J' Turbo Pascal is the de facto industry 
standard. 

5J' Turbo Pascal wins PC MAGAZINE'S 
award for technical excellence. 

5J' Turbo Pascal named "Most 
Significant Product of the Year" by 
PC WEEK. 

5J' Turbo Pascal 3.0-the fastest Pascal 
development environment on the 
planet, period. 

Suggested Retail Price: $99.95; CPIM8_80 version without 8087 and BCD: $69.95 

Features for 16-bit Systems: 8087 math co-processor support for intensive calculations. 
Binary Coded Decimals (BCD): eliminates round-off error! A must for any serious business application. 

Minimum system configuration: 128K RAM minimum. Includes 8087 & BCD features for 16·bit MS-DOS 2.0 or later and 
CP/M-86 1.1 or later. CP/M·80 version 2.2 or later 48K RAM minimum (8087 and BCD features not available). 8087 
version requires 8087 or 80287 co-processor. 

TlJbo Pascal is a registered 1rademirk of Borbnd International. Inc. CP/M is a registered Iradenak 
of Digital Research Inc. IBM is a registered InIlemark of IntemationaJ Business MacmIes Corp. MS­
DOS is a registered Iradenak of Microsoft Cap. W1rdSlar is a registered tradeInIrk of MicroPro 
International. 
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VERSION 2.0 

Learn Pascal From The Folks Who Created 
The Turbo Pascal® Family 

Borland International proudly presents Turbo Tutor, the perfect complement 
to your Turbo Pascal compiler. Turbo Tutor is really for everyone-

even if you've never programmed before. 

And if you're already proficient, Turbo Tutor can sharpen up the fine points. 
The manual and program disk focus on the whole spectrum of Turbo 
Pascal programming techniques. 

• For the Novice: It gives you a concise history of Pascal, tells you how to write a 
simple program, and defines the basic programming terms you need to know . 

• Programmer's Guide: The heart of Turbo Pascal. The manual covers the fine points 
of every aspect of Turbo Pascal programming: program structure, data types, control 
structures, procedures and functions, scalar types, arrays, strings, pointers, sets, files, 
and records. 

• Advanced Concepts: If you're an expert, you'll love the sections detailing such topics as 
linked lists, trees, and graphs. You'll also find sample program examples for PC-DOS and 
MS-DOS.8 

10,000 lines of commented source code, demonstrations of 20 Turbo Pascal features, multiple­
choice quizzes, an interactive on-line tutor, and more! 

Turbo Tutor may be the only reference work about Pascal and programming you'll ever need! 

Suggested Retail Price: $39.95 (not copy protected) 

Minimum system configuration: Turbo Pascal 3.0. PC-DOS (MS-DOS) 2.0 or later. 192K RAM minimum (CP/M-80 
version 2.2 or later: 64K RAM minimum). 



Is The Perfect Complement To Turbo Pascal@ 

It contains a complete library of Pascal procedures that 
allows you to sort and search your data and build powerful database 

applications. It's another set of tools from Borland that will give 
even the beginning programmer the expert's edge. 

THE TOOLS YOU NEED! 
TURBO ACCESS Using B+ trees: The best way to organize and search your data. Makes it 
possible to access records in a file using key words instead of numbers. Now available with 
complete source code on disk, ready to be included in your programs. 

TURBO SORT: The fastest way to sort data using the QUICKSORT algorithm-the method 
preferred by knowledgeable professionals. Includes source code. 

GINST (General Installation Program): Gets your programs up and running on other 
terminals. This feature alone will save hours of work and research. Adds tremendous value 
to all your programs. 

GET STARTED RIGHT AWAY.-FREE DATABASE! 
Included on every Toolbox diskette is the source code to a working database which 
demonstrates the power and simplicity of our Turbo Access search system. Modify it to suit 
your individual needs or just compile it and run. 

THE CRITICS' CHOICE! 
"The tools include a B+ tree search and a sorting system. I've seen stuff like this, but not as 
well thought out, sell for hundreds of dollars." -Jerry Pournell, BYTE MAGAZINE 

"The Turbo Database Toolbox is solid enough and useful enough to come recommended." 
-Jeff Duntemann, PC TECH JOURNAL 

Suggested Retail Price: $69.95 (not copy protected) 

Minimum system configuration: 128K RAM and one disk drive (CP/M-80: 48K). 1&-bit systems: Turbo 
Pascal 2.0 or greater for MS-DOS or PC-DOS 2.0 or greater. Turbo Pascal 2.1 or greater for CP/M-86 
1.0 or-greater. 8-bit systems: Turbo Pascal 2.0 or greater for CP/M-80 2.2 or greater. 

Turbo Pascal is a registered trademark and Turbo Database Toolbox is a trademark 01 Borland 
International Inc. CP/M is a registered trademark 01 Digital Research, Inc. MS-DOS is a 
registered trademark 01 Microsoft Corp. BOR 0063A 



2VR8O PASCA£ 

GRAPHIX200l·BQX® 
A Library of Graphics Routines for Use with Turbo Pasca/® 

High-resolution graphics for your IBM® PC, AT, ® XT,@ PCjr@, true PC compatibles, and the Heath 
Zenith Z-100:" Comes complete with graphics window management. 

Even if you're new to Turbo Pascal programming, the Turbo Pascal Graphix Toolbox will get you started 
right away. It's a collection of tools that will get you right into the fascinating world of high-resolution 
business graphics, including graphics window management. You get immediate, satisfying results. And 
we keep Royalty out of American business because you don't pay any-even if you distribute your own 
compiled programs that include all or part of the Turbo Pascal Graphix Toolbox procedures. 

What you get includes: 

• Complete commented source code on disk. 
• Tools for drawing simple graphics. 
• Tools for drawing complex graphics, including 

curves with optional smoothing. 
• Routines that let you store and restore 

graphic images to and from disk. 
• Tools allowing you to send screen images to 

Epson-compatible printers. 

• Full graphics window management. 
• Two different font styles for graphic labeling. 
• Choice of line-drawing styles. 
• Routines that will let you quickly plot 

functions and model experimental data. 
• And much, much more ... 

"While most people only talk about low-cost personal computer software, Borland has been doing 
something about it. And Borland provides good technical support as part of the price." 

John Markov & Paul Freiberger, syndicated columnists. 

II you ever plan to create Turbo Pascal programs that make use of business graphics or scientific 
graphics, you need the Turbo Pascal Graphix Toolbox. 

Suggested Retail Price: $69.95 (not copy protected) 

Minimum system configuration: IBM PC, Xl, AT, PCjr, true compatibles and the Heath Zenith Z-100. Turbo Pascal 3.0 or later. 192K RAM 
minimum. Two disk drives and an IBM Color Graphics Adapter (CGA), IBM Enhanced Graphics Adapter (EGA), Hercules Graphics Card or 
compatible. 

Turbo Pascal and Turbo Graphix Toolbox are registered trademarks 01 Borland International. Inc. 
IBM. Xl AT. and PCjr are registered trademarks 01 International Business Machines Corporation 
Hercules Graphics Card is a trademark of Hercules Computer Tech. Heath Zenith Z -100 is a 
trademark of Zenith Data Systems. BOR 0068A 



2VRBO PASCAl. 

.EDJ2OR 7tx>tSOX™ 
It's All You Need To Build Your Own Text Editor 

Or Word Processor 
Build your own lightning-fast editor and incor­
porate it into your Turbo Pascal® programs. 
Turbo Editor Toolbox gives you easy-to-install 
modules. Now you can integrate a fast and powerful 
editor into your own programs. You get the source 
code, the manual, and the know-how. 

Create your own word processor. We provide all 
the editing routines. You plug in the features you want. 
You could build a WordStar®-like editor with pull-down 
menus like Microsoft's® Word, and make it work as fast 
as WordPerfect.® 

To demonstrate the tremendous power of Turbo Editor Toolbox, we give you the source code for 
two sample editors: 

Simple Editor A complete editor ready to include in your programs. With windows, block commands, and 
memory-mapped screen routines. 

MicroStar A full-blown text editor with a complete pull-down menu user interface, plus a lot more. 
Modify MicroStar's pull-down menu system and include it in your Turbo Pascal programs. 

The Turbo Editor Toolbox gives you all the 
standard features you would expect to find 
in any word processor: 

• Wordwrap 
• UN-delete last line 
• Auto-indent 
• Find and Find/Replace with options 
• Set left and right margin 
• Block mark, move, and copy 
• Tab, insert and overstrike modes, 

centering, etc. MicroStar's pull-down menus. 

And Turbo Editor Toolbox has features that word processors selling for several hundred dollars can't begin to match. 
Just to name a few: 

[!] RAM-based editor. You can edit very large [!] Multiple windows. See and edit up to eight 
files and yet editing is lightning fast. documents-or up to 'eight parts of the same 

[!] Memory-mapped screen routines. In- document-all at the same time. 
stant paging, scrolling, and text display. [!] Multitasking. Automatically save your 

[!] Keyboard installation. Change control text. Plug in a digital clock, an apPOintment 
keys from WordStar -like commands to any that alarm-see how it's done with MicroStar's 
you prefer. "background" printing. 

Best of all, source code is included for everything in the Editor Toolbox. 

Suggested Retail Price: $69.95 (not copy protected) 

Minimum system configuration: tBM PC, XT, AT, 3270, PCjr, and true compatibles. PC-DOS (MS-DOS) 2.0 or greater. 192K RAM. You must be 
using Turbo Pascal 3.0 for IBM and compatibles. 

Turbo Pascal is a registered trademark and Turbo Edilor Toolbox is a trademark of Borland 
International. Inc. WordStar is a registered trademark of MicroPro International Corp. Word and 
MS-DOS are registered trademarks of Microsoft Corp. WordPerfect is a trademark of Satellite 
Software International. IBM, Xl, AT, and PCjr are registered trademarks of International Business 
Machines Corp. BOR 0067 A 



Secrets And Strategies 01 The Masters Are 
Revealed For The First Time 

Explore the world of state-of-the-art computer games with Turbo GameWorks. Using 
easy-to-understand examples, Turbo GameWorks teaches you techniques to quickly create 
your own computer games using Turbo Pascal.e Or, for instant excitement, play the three 

great computer games we've included on disk-compiled and ready to run. 

TURBO CHESS 

Test your chess-playing skills against your computer challenger. With Turbo GameWorks, you're on your 
way to becoming a master chess player. Explore the complete Turbo Pascal source code and discover 
the secrets of Turbo Chess. 

"What impressed me the most was the fact that with this program you can become a computer 
chess analyst. You can add new variations to the program at any time and make the program play 
stronger and stronger chess. There's no limit to the fun and enjoyment of playing Turbo GameWorks 
Chess, and most important of all, with this chess program there's no limit to how it can help you 
improve your game." 

-George Koltanowski, Dean of American Chess, former President of 
the United Chess Federation, and syndicated chess columnist. 

TURBO BRIDGE 

Now play the world's most popular card game-bridge. Play one-on-one with your computer or against 
up to three other opponents. With Turbo Pascal source code, you can even program your own bidding 
or scoring conventions. 

"There has never been a bridge program written which plays at the expert level, and the ambitious 
user will enjoy tackling that challenge, with the format already structured in the program. And for the 
inexperienced player, the bridge program provides an easy-to-follow format that allows the user to start 
right out playing. The user can 'play bridge' against real competition without having to gather three 
other people." 

-Kit Woolsey, writer of several articles and books on bridge, 
and twice champion of the Blue Ribbon Pairs. 

TURBO GO-MOKU 

Prepare for battle when you challenge your computer to a game of Go-Moku-the exciting strategy 
game also know as "Pente."''' In this battle of wits, you and the computer take turns placing X's and D's 
on a grid of 19X19 squares until five pieces are lined up in a row. Vary the game if you like, using the 
source code available on your disk. 

Suggested Retail Price: $69.95 (not copy protected) 
Minimum system configuration: IBM PC, Xl, AT, Portable, 3270, PClr, and true compatibles. PC·DOS (MS·DOS) 2.0 or later. 192K 
RAM minimum. To edit and compile the Turbo Pascal source code, you must be using Turbo Pascal 3.0 for IBM PCs and 
compatibles. 

Tur60 Pascal is a registered trademark and Turbo GameWorks is a trademark of Borland 
International. Inc. Pente is a registered trademark of Parker Brothers. IBM, XT, AT, and PCjr are 
registered trademarks of International Business Machines Corporation. MS-DOS is a registered 
trademark of Microsoft Corporation. 
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REFLEX 
FOR THE MAC'M 

The easy-to-use relational database that thinks like a spreadsheet. 
Reflex for the Mac lets you crunch numbers by entering formulas and link 

databases by drawing on-screen lines. 

Some of the things Reflex for the Mac wi do for you are included on the 
examples disk: 
• A 1040 tax application with Schedule A. 

Schedule B, and Schedule D, each contained in a 
separate report document. 

• A portfol io analysis application with linked 
databases of stock purchases, sales, and 
dividend payments. 

• A checkbook application. 

• A client bill ing application set up for a law office, 
but easily customized by any professional who 
bills time. 

• A parts explosion appl ication that breaks 
down an objeCt into its component parts for 
cost analysis. 

Reflex for the Mac accomplishes aI/ of these tasks without programming­
using spreadsheet-like formulas. Some other Reflex for the Mac features are: 
• Visual database design. 
• "What you see is what you get" report and form 

layout with pictures. 
• Automatic restructuring of database files when 

data types are changed, or fields are added , 
and deleted. 

• Display formats which include General, Decimal, 
Scientific, Dollars, Percent. 

Critic's Choice 

• Data types which include variable length text, 
number, integer, automatically incremented· 
sequence number, date, time, and logical. 

• Up to 255 fields per record. 
• Up to 16 files simultaneo~sly open. 
• All MacintoshN fonts and ~tyles are selectable 

for individual fields and labels. 

" ... a powerful relational database ... uses a visual approach to information management." InfoWorid 
" . .. gives you a lot of freedom in report design; you can even import graphics." A+ Magazine 
" ... bridg.es the gap between the pretty programs and the power programs." Stewart Alsop, PC Letter 

, 
BORLAND 
INTERNATIONAL 

4585 SCO TTS VALLEY DRIVE 
SCOTTS VALLE Y, CALIFORNIA 95066 

I SB N 0 -8 7524-153-0 
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